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Field Assistant is a standalone tool you can install on your computer or laptop to access a single Open or i-Vu® XT 
controller, several controllers, or a network of Open or i-Vu® XT controllers and routers. You do not need to be 
connected to the Internet. You can communicate with the devices using local access or over an IP network. 

NOTE  A Field Assistant system allows a maximum of 750 Open controllers. Field Assistant does not work with CCN. 

 

 

 
 

Field Assistant basics 

In Field Assistant, you can use a Local Access connection. Or, you can use an IP connection to access an entire 
network of routers and controllers. 

After you have connected to a router or controller, you can:  

• Upload parameters and source files (control programs, drivers, graphics, .touch files, and BACview® files) 
from the controller to Field Assistant 

• Commission and start up equipment  

• Adjust setpoints and other control parameters 

• View current trends stored in the controller 

• Set and change schedules in the controller 

• Run preconfigured reports that display locked values, points list, network I/O, alarm sources, equipment and 
controller status, and test and balance configuration 

• Use the Snap and ViewBuilder applications to edit or create new control programs and views 

• Download programs, schedules, parameters, and BBMD tables to controllers 

• Export updated source files  

 

To use Field Assistant, you must understand these terms: 
  

Source Files Includes any or all of the following files:  

• Control programs (.equipment)  

• Graphics (.view)  

• Screen files (.touch, .bacview)  

• Drivers  (.driver) 

Parameters  Editable properties within a control program or driver  

What is Field Assistant? 
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Import Brings files into Field Assistant. Import source files (sourcefiles.zip) from the Field 
Assistant Launcher. 

NOTE  Your manufacturer or representative must supply the source files. 

Export Takes source files from your Field Assistant system to use in another system. Export 
source files (sourcefiles.zip) from the Field Assistant Launcher. 

Download Sends source files, schedules, or parameters from Field Assistant to the controller. 

Upload Retrieves source files or parameters from the controller and stores them in Field 
Assistant. 

 

 
 

Field Assistant Tools 

Develop and configure graphics and a system database for your Field Assistant system using the following Field 
Assistant tools, downloaded from your Tech Tools USB drive. 

 

Use... To... 

ViewBuilder Create or edit graphics 

EquipmentBuilder Build or edit control programs (.equipment files) for programmable 
controllers. Can also produce graphics, sequence of operation, and 
screen files  

Alarm Notification Client Receive a message on any networked computer that is running the Field 
Assistant Alarm Notification Client application 

Virtual BACview® View and change property values and the controller's real time clock 

BBMD Configuration Tool Configure BACnet/IP Broadcast Management Devices (BBMDs) 

NOTE  If your system has multiple routers that reside on different IP 
subnets, you must set up one router on each IP subnet as a BACnet/IP 
Broadcast Management Device (BBMD).  

MSTP Capture Tool Capture BACnet traffic on MS/TP. It is intended for situations where 
Carrier Control Systems Support needs a network capture to 
troubleshoot communications.  

Test & Balance • Calibrate airflow in a VAV or VVT Zone controller  
• Calibrate the static pressure in a VVT Bypass controller  
• Commission air terminals 
• Override reheat and terminal fans 
NOTE  Use Test & Balance to manipulate the controllers associated with 
an air source, but not the air source itself, or heating and cooling 
equipment, such as chillers and boilers. 

Snap Build custom control programs using individual blocks of programming 
code called microblocks 
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LonWorks Integration Tool Generate the microblock addresses automatically for third-party 
LonWorks points 

AppLoader Use to download .clipping files to restore factory defaults and check 
Module Status (Modstat) through the Rnet port 
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The computer should have at least: 
• Dual core processor 
• 4 GB RAM 
• 30 Gigabyte hard drive 
• Communications link of 10 Mbps or higher 
• 32 or 64-bit operating system 
  
The Field Assistant application will work with slower computers and slower links, but the results may not be 
satisfactory. 
  

You must use a computer with a Windows® operating system and either Internet Explorer® v11 or Microsoft® 
Edge browser. A Field Assistant v7.0 or later system is supported on any of the following operating systems 32 or 
64-bit operating systems..  
• Windows® 10 Professional 
• Windows® 8.1 Professional and Enterprise 
• Windows® 7 Professional and Ultimate 

 
 

Field Assistant v6.5 and later only uses an Apache Derby database. If you have an Access database from a Field 
Assistant version previous to v6.5 that you want to use in v7.0, see Converting Access databases to Derby (page 
6). 

 

The memory requirements will vary based on the: 
• number of pieces of equipment and device instances 
• size of the control programs 
 

 
For this 
size 
system... 

With this number of... The computer should have at least a dual core processor and... 

Instances of 
equipment 
and devices 1 

Physical 
Points and 
Display 
Objects 

Passmark 
Total 
Score 2 

Passmark 
Single- 
threaded 
Score 

RAM 
Minimum/ 
Recommend- 
ed 

JVM Memory 
Minimum/ 
Recommend- 
ed 

Operating 
system 

Small 0 - 250 0 - 1000 2000 800 4 / 4GB 1 / 1GB 32 or 64-bit 
server 3 

Medium 250 - 1000 1000 - 5000 3000 1000 4 / 8GB 2 / 4GB 64-bit 
server 

Large 1000 - 
10,000  

5000 - 
50,000 

5000 1400 6 / 12GB 4 / 8GB 64-bit 
server 

Huge more than 
10,000 

more than 
50,000 

6500 1600 16 / 16GB 4 12 / 12GB 64-bit 
server 

Computer, operating system, and database requirements for Field 
Assistant 
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1   Total number of control programs and controllers-+. 
2   For more information, see www.CPUbenchmark.net. 
3   If using 32-bit, you cannot use more than 1.2GB for the JVM. 
4   For a huge system with minimal user activity, the average piece of equipment or instance device requires 

approximately 300KB of server RAM. Contact Carrier Control Systems Support for server sizing recommendations. 
 

 
 

To set up a computer and web browser to view Field Assistant 

• Set the monitor's screen resolution to a minimum of 1024 x 768 with 24- or 32-bit color quality 

• You may want to disable the computer's navigation sounds. 
  

NOTES   

• The instructions below are for Internet Explorer® 11. Other versions may vary slightly. See your web browser's 
Help if necessary. 

• If the menu bar is not visible, right-click on the window's header, and then select Menu bar. 

  

Browser settings Where to change setting in IE11 

Accept First-party and  
Third-party cookies.* 

Tools > Internet Options > Privacy > Advanced button 

Automatically check for newer 
versions of stored pages* 

Tools > Internet Options > General > Browsing history > Settings button 

Load ActiveX Control* Tools > Internet Options > Security > Custom Level button. Under ActiveX 
controls and plug-ins, set the following: 
• Download signed ActiveX controls > Prompt 
• Download unsigned ActiveX controls > Disable 
• Run ActiveX controls and plug-ins > Enable 
• Script ActiveX controls marked safe for scripting > Enable 

Select Play animations in web 
pages 

Tools > Internet Options > Advanced > under Multimedia 

Disable all the options on the 
Explorer Bar 

View > Explorer Bars 

Disable web browser's pop-up 
blockers 

Tools > Pop-up Blocker > Turn Off Pop-Up Blocker 

Disable external toolbar pop-up 
blockers 

Varies 

Hide the browser's toolbars View > Toolbars 
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To... Do the following... 

Maximize the web browser  
window 

Press F11 on your keyboard to turn full-screen mode on\off, or use the 
minimize/maximize button in the top right corner of the browser window. 

* Field Assistant cannot function without this setting. 

 

 
 

Converting Access databases to Derby 

Field Assistant v6.5 and later creates sites using Derby databases. Older versions of Field Assistant created sites 
using Access, which is not compatible with Field Assistant v6.5 or later. In order to open v6.0 or older Field 
Assistant sites created with Access, these sites must be converted to Derby by using the Field Assistant v6.0 
database conversion file. This update file is located on the Tech Tools v7.0 USB drive.  

  CAUTION  This update can only be applied to Field Assistant v6.0. If you are upgrading from a pre-6.0 
version, you must first install Field Assistant v6.0 and upgrade all of your Field Assistant systems to v6.0. Then you 
must install Tech Tools v7.0 and use the following instructions to convert your databases through v6.0. You cannot 
open a system in v7.0 until you have converted them. 

 

1 Open the Field Assistant v6.0 Launcher screen.   

NOTE  Do NOT click the arrow to start a system. 

2 From the Field Assistant v6.0 Launcher, click Help > Update to open the Apply Update dialog. 

 

 

3 On the Apply Update dialog, in the Update File field, browse to the Tech Tools v7.0 Installation USB drive, 
open FA60_DB_Migration_Update > WS60_Migrate_Access_To_Derby.update file and click Select.   

4 Click the Apply and Restart Now or Update with Restart Later button. 

5 From the Field Assistant v6.0 Launcher, click Help > Database Upgrade Utility.  

NOTE  This option appears only after applying the update file. 

6 In Target Coversion Directory, browse to the i-Vu_Tools_7.0\webroot folder and click Select. 

7 In Systems To Convert, browse to your i-Vu_Tools_6.0\webroot folder and click Select. You can use the Shift 
or Ctrl key to multi-select databases.  

 CAUTION  You must get your database(s) from the webroot directory only. If, for instance, you have files 
on a USB drive, you must first place them on your computer in the i-Vu_Tools_v6.0\webroot folder. No other 
path is accepted. 
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8 Click the Start Conversion button. 

NOTES 

○ The top progress bar Overall conversion progress displays the progress of all of the databases you 
selected. The total conversion is finished when the bar reaches the end. 

○ The two lower bars show the conversion progress of each database.  

9 When complete, click Exit. 

10 Close the Field Assistant Launcher v6.0. 

11 You can now start your systems in the Field Assistant Launcher v7.0. See Getting Started (page 8). 
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1 If you will be using a database from a pre-v6.5 version of Field Assistant, you must first convert the Access 
database to a Derby database. See Converting Access databases to Derby (page 6) for details.  

2 Set up your computer and browser (page 5). 

3 Do one of the following: 
Connect to a controller's Local Access port (Open device only) (page 8) 
Connect to a controller over an IP network (Open device or i-Vu® XT device) (page 9) 

4 Start Field Assistant. (page 10) Field Assistant finds and displays the controller you are connected to, as well 
as, any other controllers on its local network. 

5 Upload source files from a controller (page 11). 

6 Start up, commission, or change parameters, programs, or drivers as needed. See Working with equipment 
(page 22). 

7 Export source files from the Field Assistant Launcher (page 12) to use in the i-Vu® Standard, Plus, or Pro 
application. 

  

 

 
 

To connect to a controller's Local Access port (Open device only) 

PREREQUISITE  For Field Assistant to communicate with the controller, the controller must have been downloaded 
with at least its driver (4.x or later). 

 CAUTION   If multiple controllers share power but polarity was not maintained when they were wired, the 
difference between the controller's ground and the computer's AC power ground could damage the USB Link and 
the controller. If you are not sure of the wiring polarity, use a USB isolator between the computer and the USB Link. 
Purchase a USB isolator online from a third-party manufacturer. Plug the isolator into your computer's USB port, 
and then plug the USB Link cable into the isolator. 

Using a USB Link 
1 If your computer does not already have the USB Link driver installed, install it before you connect the USB Link 

to your computer.  

NOTE  The driver is installed with Field Assistant. But if needed, you can get the latest driver from  
http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx. 

2 Connect the computer to the local access port of the controller, ZS sensor, or an SPT sensor using the USB 
Link cable(s). 
  

Getting started 
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USB Link

Connect to
Local Access port

12 ft

Connect to
USB port

7 3/4 in.

 

 

NOTE  If using a USB isolator, plug the isolator into your computer's USB port, and then plug the USB Link 
cable into the isolator. 

  

 

 
 

To connect to a controller over an IP network (Open device or i-Vu® XT 
device) 

1 Connect a CAT5 Ethernet cable to your computer and to: 

○ The controller's Ethernet port 

or 

○ A hub on the same IP network as the controller 

2 Set your computer's IP parameters so that it can communicate on the controller's IP network. 

3 Open Field Assistant Launcher, and start your system. See Start Field Assistant (page 10). 

4 On the Devices page > Advanced tab, set the Field Assistant BACnet/IP network number to match the number 
of the controller's BACnet/IP network (supplied by your manufacturer or representative.). 

5 On the Devices page > Manage tab, click Find Devices. 

6 If you have multiple routers, select one at a time on the navigation tree. Click Find Devices to find the devices 
under that router. 

7 On the Devices page > Manage tab, select a controller in the list. Use Ctrl+click, Shift+click, or the Select All 

checkbox to select multiple controllers. Click  Upload All Content. 

8 The message appears This will upload all content for the controller. Are you sure you want to do this? Click 
OK. 

NOTE  If a message appears stating that a file is missing, you must stop and import the source files provided 
by your manufacturer or representative. Follow these steps: 

a) Close Field Assistant.  

b) Click  on the Launcher to stop your system. The Launcher will disappear and then take a few seconds 
to reappear. 

c) Click Source Files . Select the sourcefiles.zip file. 

d) Click  to start your system. 
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e) Click . 

f) Return to Step 1. 

9 Start up, commission, or set parameters as needed. 

NOTE  You can make changes to one controller and then copy the changes to other controllers that have the 
same control program. See Copying properties from one controller to another (page 56).  

 

 
 

To start Field Assistant 

1 From your desktop, select Start > All Programs > i-Vu_Tools_ x.x > Field Assistant. 

2 Click  on the Field Assistant Launcher and type your System Name.  
The System Name cannot: 
• Begin with a number. 
• Contain special characters other than a dash or an underscore. 
• Exceed 40 characters. 
• Contain capital letters or spaces. Use an underscore or dash between words. 

3 Click Create. 

4 If your manufacturer or representative provided source files, click , browse to sourcefiles.zip, 
then click Open. 

5 Select your System Time Zone. Your selection applies to your current system when you click .  

6 Under Communications, select the method you are using to connect to a controller or system: 

○ IP network - select your IP. See To connect to a controller over an IP network (page 9). 

○ Local Access - select your USB Comm port from the drop-down list. 

NOTE  If you are using a USB Link (#USB-L), you must connect it to your computer and the controller 
before launching Field Assistant in order for your Comm port to appear in the drop-down list. If you do not 
see your Comm port, close the Field Assistant Launcher, make the connection, then restart Field 
Assistant. 

7 Click  to start your system. 

○ If using local access, Field Assistant will find and display the device you are connected to and any other 
controllers on its local network. You must upload source files (page 11) for any controllers you need to 
work with.   

○ If using an IP network, you must click Find Devices from the System  , then select a router in the 
navigation tree, and click Find Devices again. 

NOTE  When you click  to stop your system, the Field Assistant Launcher disappears for a few seconds and 
then reappears. 
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To import source files 

You can import and export source files from the Field Assistant Launcher. If the controllers have full source in 
them, you do not need to import the source files because you upload them from the controllers. 

1 If Field Assistant is running, close the Field Assistant window and click  on the Launcher to stop your 
system. The Launcher will disappear and then take a few seconds to reappear. 

2 Click Source Files . Select the sourcefiles.zip file. 

3 Click  to start your system. 

 

 
 

To upload source files from a controller 

NOTE  For best results, connect your computer to a controller on the same network segment as the controllers that 
you want to upload. 
  

1 Click the link (shown below) to the controller that your computer is connected to. 
  

 
  

2 On the Properties page, click , and then click OK. 

NOTE  If a message appears stating that a file is missing, you must stop and import the source files provided 
by your manufacturer or representative. Follow these steps: 

a) Close Field Assistant.  

b) Click  on the Launcher to stop your system. The Launcher will disappear and then take a few seconds 
to reappear. 

c) Click Source Files . Select the sourcefiles.zip file. 

d) Click  to start your system. 

e) Click . 

f) Return to Step 1. 

3 Start up, commission, or set parameters as needed. Perform the services required. See Working with 
equipment (page 22). 

4 If you have more controllers, move your USB Link cable to the next controller or to a controller on another 
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network, then repeat steps 1–3.  

NOTES  

○ To upload more than one controller at the same time, select the System  on the navigation tree, then 
go to the Devices page > Manage tab. Select the controller(s) you wish to upload in the list on the page. 

Ctrl+click to multi-select, or enable Select all. Select Upload All Content, then click .  

○ After uploading, we recommend that you give each controller a unique name by selecting the router level 
in the navigation tree and going to Devices page > Manage tab. Click in the Name field to edit. 

 

 
 

To export source files 

1 Close the Field Assistant window.  

2 In the Field Assistant Launcher, click  to stop your system.   

3 Click  . 

4 Browse to a location where you want to save the source files.  

NOTE  Do not change the extension (sourcefiles.zip). 

5 Click Save Files. 
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Navigating the system 

NOTE  Use only the Field Assistant interface to navigate through Field Assistant; do not use the web browser’s 
navigation buttons. 

To navigate to an item in the system 
1 Select an item on the navigation tree. 

2 Use the action buttons and their drop-down menus to navigate to specific types of information about the 
selected tree item. 

3 Use the tabs to filter the information further. 
 

To navigate using links  
Click links to jump to related pages.  
 

Getting to know the Field Assistant  interface 
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To show, hide, or resize the navigation tree 

Click  at the top of the navigation pane to hide or show the navigation tree. 

Click and drag the tab on the right side of the tree to adjust its width. 
 

 

 

 

 
 

Zooming in and out 

• To zoom in and out on the Field Assistant interface: 

○ Hold down Ctrl and press + or -. Press Ctrl+0 to return to 100%. 

○ Hold down Ctrl while rolling your mouse wheel. 

○ Use your web browser's zoom functions. 

• If a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the action pane. 
Select Scale to Fit again to return the graphic to its original size.  
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Using right-click menus 

You can right-click the following items to select options: 
 

A tree item  The Graphics page 

 

 

 

A property A trend 

 

 

 

 

 
 

To print the action pane 

Click  at the top of the page to print the contents of the action pane. Set the print orientation to Landscape in 
the Print dialog box.  

 TIP  To print a Graphics page that exceeds the size of the action pane, right-click the graphic and select Scale 
to Fit. 
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Colors and status in the Field Assistant interface 

The following colors indicate equipment status throughout Field Assistant interface. These colors are visible on 
Property pages, Graphics pages and in the setpoint graphs.  
  

Color Color Name Status Code Condition Indicated 

 Purple 0 or 15 In a controller—non-operational or no communications 
In equipment—a hardware or software error 

 Charcoal 14 In a controller—a download is required or is already in 
progress 
In equipment—a controller has stopped 

 Coral 13 Control program error 

 Red 2 or 9 Heating or cooling alarm 

 Orange 8 Maximum cooling 

 Dark blue 3 Maximum heating 

 Yellow 7 Moderate cooling 

 Light blue 4 Moderate heating 

 Grey 1 Unoccupied/inactive 

 White 10 Occupied/active 

 Light green 6 Free cooling 

 Green 5 In a controller—operational or operational read-only 
In equipment—No heating or cooling 
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On the Devices page > Manage tab, you can:   

• Search the network to populate the system with routers and controllers (page 17) 

• Upload control programs, drivers, graphics, and screen files (page 22) 

• Perform downloads to individual or multi-selected controllers (page 31)  

  

 

 
 

Find and upload routers and controllers 

1 Select the System  in the navigation tree.  

2 On the Devices page > Manage tab, click Find Devices to discover your routers. 

3 Once routers are found, select one router at a time in the left-hand navigation tree and click Find Devices 
again.  

4 Once controllers are found, you must upload content from the routers and controllers. Select one or more 
devices in the list on the Manage tab and click Upload All Content to upload drivers, graphics, screen files, 
and control programs to the Field Assistant application. Use Ctrl+click, Shift+click, or both to select multiple 
items. 

NOTE  If Show Control Programs is checked, all control programs are listed. If you have multiple control 
programs in one controller, you will see every control program in the list. If it is not checked, the list only shows 
the individual controllers and their model. The same information is uploaded, this option just controls what 
you see on the Manage tab and you can switch back and forth.  

5 Click OK when you see the message This will upload all content for the controller. Are you sure you want to 
do this?. When complete, a check mark under Status indicates a successful upload.  

NOTES 

○  If an error message appears, click on the message to view an explanation. 

○ Uploading can be time consuming, especially for multiple controllers.  

○ The MAC address shows to the left of the controller name in the navigation tree only. Programmable 
controllers show multiple equipment listings with the same MAC address, based on control programs 
downloaded from EquipmentBuilder or Snap. 

○ To view the driver names after uploading, select the Advanced tab or right-click the controller in the 
navigation tree and select Driver Properties or Module Status. 

 

  TIPS  

• Click the i symbol   in the upper left corner to display the status of the latest operation. 

• Status messages are color coded as follows: 

Setting up and configuring your system 
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○ Red - reports an error 

○ Blue - requires action 

○ Green - indicates an upload or download is in process 

 

 
 

Verify network and device settings 

  CAUTION  The Field Assistant application automatically assigns a BACnet Network IP number and the Server 
Device Id for the application. Do not change these addresses unless absolutely necessary!   

NOTE  If you have more than 99 routers, you must set your own addresses. 

 

1 Select the System  in the navigation tree and go to the Devices page > Advanced tab to make any 
necessary changes.  

2 Click Accept.  

 

Verify and edit the following fields only as necessary.  

System level 
○ BACnet/IP network — default is 1600 (The maximum number allowed is 65,534) 

NOTE  Typically, you should not need to change this. 

○ Server Device Id — address of the Field Assistant web server (default is 169998) 

○ Communications Time-out (in milliseconds) — increase this value only if downloads to controllers or 
routers fail with communication time-out errors.  

○ Communication Retries (default is 3) 

○ Optimize download for Open PIC controllers — by default, Full Source files are downloaded to Open PIC 
controllers because Optimize ownload for Open PIC controllers is unchecked 

○ Include graphics in Open programmable controller download — you can increase download speed by 
unchecking Include graphics in Open programmable controller download. If you are not changing the 
graphics, you may not want to include them in every download in order to save time. 

○ BACnet Discovery — locates all accessible BACnet networks, BACnet devices, and BACnet objects on a 
BACnet network. Typically used to integrate BACnet third-party devices into the Field Assistant system. 
See To discover third-party BACnet networks, devices, and objects (page 20). 
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Router level  
Select the router in the navigation tree and go to Devices > Advanced tab. 

○ Router to Arcnet network and Auto-Assign 

○ Router to MS/TP network and Auto-Assign 

○ Device Identifier 

 

 
 

Set up third-party integration 

You can integrate third-party devices into a Field Assistant system if the following are true: 
• The third-party devices are physically connected on the Field Assistant system’s network. 
• You have a Carrier controller that supports third-party integration. 
• You have the correct Carrier driver for the third-party protocol. 
• You have enabled a port for a third-party protocol on the Carrier controller's driver page. 

  
To read from or write to a third-party device, you need the following information from the third-party vendor: 
• Protocol 
• Third-party device’s network address 
• Memory location of the object in the device you want to read from or write to 
If you are integrating with BACnet devices, you can use the Field Assistant BACnet Discovery (page 20) feature to 
gather this information. 
 

Before you begin a third-party integration, study the Carrier controller’s Installation and Start-up Guides and the 
third-party protocol’s Integration Guide. Both are available on the Carrier website (http://www.hvacpartners.com). 
 

 

 

 

 

 

 

 

http://www.hvacpartners.com/
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The following Carrier routers let you integrate the allowed number of third-party points into your Field Assistant 
system: 

This router... 

i-Vu® Open Link 

Carrier® ChillerVu™ 

i-Vu® XT BACnet Link 

Allows this number of non-BACnet third-party points... 

500 

1000 

1500 

   
NOTE  The point allowance of the i-Vu® Open Link that provides third-party points applies to only itself. For 
example, if you download control programs that use 125 third-party Network I/O points, you cannot apply the 
unused 125 points to a different router.   

 

 
 

To discover third party BACnet networks, devices, and objects 

The Field Assistant BACnet Discovery feature locates all accessible BACnet networks, BACnet devices, and BACnet 
objects (including devices in your Field Assistant system) on a BACnet network. The information gathered in this 
process is typically used to integrate third-party BACnet devices and their BACnet objects into the Field Assistant 
system. 

 

To use BACnet Discovery: 

1 Select the System  in the navigation tree and then the Devices page > Advanced tab.  

2 Click the BACnet Discovery Start button to discover BACnet sites for the system. An item called Discovered 
Networks appears in the tree. After all sites are found, close the status dialog box. 

3 To discover BACnet networks, select Discovered Networks, then click Go. A list of all BACnet networks appears 
in the navigation tree. After all networks are found, close the status dialog box. 

 TIP  Run a commstat manual command to determine which device routes to each network. The BACnet 
Bind Show Network section of the Commstat window shows the IP address of the router to each network.   

4 To discover BACnet devices on a network, select a network in the navigation tree, then click Go. After all 
devices are found, close the status dialog box. Click  beside an item to expand the list of devices.  

5 To discover BACnet objects on a device, select the device on the navigation tree, then click Go. After all 
objects are found, close the status dialog box. A list of all BACnet objects in this device appears on the 
navigation tree.  

 TIP  Make sure you are discovering objects in the correct device. It may take some time to discover 
objects in devices with more than 100 objects. 

6 Optional:  Do the following to export the BACnet information so that it can be used in the Snap application: 

a) On the navigation tree, select a discovered network with devices or a single device. 

b) Click Export. 

c) Name and save the .discovery file in any folder. 
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NOTES 

• Some third-party BACnet devices may not be discovered because they do not support the BACnet methods 
required for auto discovery. 

• If the discovery process returns ambiguous information, such as multiple points with similar names, contact 
the third-party manufacturer's representative for clarification. 

• Device configuration or network load can prevent the Field Assistant interface from showing all BACnet 
devices. If you do not see a BACnet device that you expect to see, check the system's BBMD configurations. If 
the configurations are correct, try the discovery process again. 
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You can view and adjust equipment operation from the following pages: 
  

Devices pages 

Select the system  on the navigation tree to view 
the Devices page, where you can: 

• Upload source files or just parameters 

• Download source files, schedules, parameters, 
or BBMD tables 

• Check status and error messages 

• View model, IP address, drivers, device ID 

• Edit device names  

 

Graphics pages (page 52) 

You can view and adjust your essential building 
controls on most Graphics pages. 

Graphics show the current status of mechanical 
equipment and may include an adjustable setpoint 
control or other editable properties 

To upload a graphic from ViewBuilder, double-click 
the controller in the navigation tree or right-click and 
select Configure. 

 

Working with equipment in the interface 
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Properties pages (page 56) 

Each piece of equipment and each microblock has a 
Properties page. You can view and adjust more 
equipment properties on a Properties page than on 
its corresponding Graphics page. Each microblock 
has a Properties page, or pop-up.  

 

Logic pages (page 62) 

Logic pages show the control program for a piece of 
equipment. Use the sequence of control and yellow 
status values on the Logic pages for troubleshooting 
your mechanical equipment. 

 

Properties/Microblock popups  

To open a microblock pop-up where you can view 
and change properties: 

• Click a microblock on a Logic page 

• Click the bold, underlined microblock name on 
a Properties page 

• Right-click a value and then select Detail 
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Working with control programs in the Field Assistant interface 

The source files given to you by your manufacturer or representative could contain new control programs. You 
might revise or create a new one in the Snap application.  

You can use the Field Assistant interface to:  

• Edit Existing - Downloads programmable controller files to your computer to edit in Snap or EquipmentBuilder  

• Add New - Obtains files for the Field Assistant application to add to a controller or to replace an existing 
control program 

• Delete Unused - Deletes unused control programs 

• Update - Changes the control program, view, driver, and screen files to use the current SAL library version. See 
Update the SAL library (page 78) for complete instructions. 

• Reload a revised control program - place the control program in the <local drive>\i-
Vu_Tools_x.x\webroot\<system>\programs folder. 
On the Field Assistant navigation tree, right-click the equipment, then select Reload Control Program. 
Reloading updates all instances of a control program throughout the system and marks the controller(s) for 
download. Field Assistant determines the appropriate download option (page 32) based on what changed in 
the control program. 

 
You can use EquipmentBuilder or Snap to create your control programs (.equipment files). 

• EquipmentBuilder can also produce a graphic (.view file), screen file, and a sequence of operation, based on 
the equipment options you select.   

• If using Snap, you must create your graphics separately in ViewBuilder. See Snap Help for detailed 
instructions on creating a custom control program. 

After creating your control program, load it into the Field Assistant application and download it into the controller. 
See Add or delete a custom control program (page 25).  

NOTE  If you change a control program in the Snap application and it does not display correctly in the Field 
Assistant interface, Ctrl+right-click the Field Assistant action pane, and then select Refresh. 
  

 
 

To edit a control program 

You cannot edit a PIC control program in the Snap application. 

To obtain the control program to be edited 
1 Right-click the equipment on the Field Assistant navigation tree, then select Configure. 

2 In the Control Programs section, click Edit Existing. 

3 Click Save as and browse to the folder you want to put the file in. 

4 Click Save. 

5 Click Close.  

 

Edit the control program in the Snap application. See Snap Help for more information. 

 CAUTION  Be sure to save it with a different name. 
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To put the edited control program back in your database 
1 Right-click the equipment on the Field Assistant navigation tree, then select Configure. 

2 In the Control Programs section, click Add New. 

3 Browse to select the control program and click Open. 

4 Click Continue. 

5 Click Close. 

6 Click Close again. 

 

To download the edited control program to your controller(s) 

Click . See Downloading to controllers (page 31). 

 

 
 

Add or delete a custom control program 

To save time when testing custom control programs, you can use DEBUG MODE (page 86) in the Field Assistant 
interface for one controller at a time. 

  CAUTION  Never leave your Field Assistant system without unchecking DEBUG MODE first and and then 
downloading all content. The source files are not in the controller until you complete both steps.  

To add a new control program to a programmable controller 
1 Select the router in the navigation tree. 

2 Select Devices > Manage tab. 

3 Select the controller in the list on the page. 

4 If you are adding a new control program, click the Add Control Program button . A dialog 
window appears. 

5 Enter a name for your control program in Display Name and select your controller in the Controller drop-down 
list. 

NOTES 

○ If you already have the maximum number of control programs for a controller, it will not appear in the list.  

○ Optional:  You can change the control program's Reference Name if needed. 
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6 Do one of the following: 
  

If the control program is...  

In the Control Program drop-down list Select the control program. 

Not in the Control Program drop-down list a.  Click Add New. 

b.  Browse to select the control program. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

 

7 To upload a graphic, click Add New under Views and browse to your .view file. 

8 Click Continue. When message appears File added successfully, click Close. 

9 Click Close again. 

10 Right-click on the programmable controller in the controller list and select Check Status from the list. The 
status of the controller should say File Mismatch. 

11 Click the Download All Content (page 31) button.  

 

NOTE  If you need to edit the Object Instance, right-click the control program in the navigation tree and then select 
Configure. Click  next to the field for additional information. 

 

To delete a single control program in a programmable controller 
1 Select the router in the navigation tree. 

2 Right-click the the desired controller/control program in the list on the Devices page > Manage tab and click 
Delete Selected from the list.  

3 The message appears Do you wish to remove a controller and all its descendants? Click OK. 

IMPORTANT!  The process is not finished until you complete the following steps. 

4 Highlight the programmable controller in the controller list again, and select Check Status. The status of the 
controller should say File Mismatch. 

5 Click File Mismatch and click the Download button. This deletes the files from the controller. 
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To delete all control programs in a programmable controller 
1 Select the router in the navigation tree. 

2 Right-click the desired controller/control program in the list on the Devices page > Manage tab and select 
Delete Programs. Click OK when the following message appears This will delete all programs in this 
controller. Are you sure? 

IMPORTANT!  The process is not finished until you complete the following steps. 

3 Highlight the programmable controller in the controller list again, and select Check Status. The status of the 
controller should say File Mismatch. 

4 Click File Mismatch and click the Download button. This deletes the files from the controller. 

 

 
 

Working with drivers in the Field Assistant interface 

You can make the following changes to a driver in the Field Assistant interface.  

• Change or upgrade a driver for controllers. See topic below. 

• Routers only:  

Reload a driver if it becomes corrupt (for example, a driver page is missing). On the Field Assistant navigation 
tree, right-click the router or driver, then select Reload Driver. Reloading updates all instances of the driver 
throughout the system and marks the router for an All Content download. Changes you made on the driver 
pages in Field Assistant remain in effect.  

After you make these changes, you must Download All Content (page 31) to the affected devices. 

 

 
 

To change or upgrade a driver 

1 On the Field Assistant navigation tree, right-click the controller, then select Driver Properties > Update tab. 

2 If other controllers in the system use this driver, select which controllers you want to change.  

 

3 Do one of the following: 
  

If the driver is...  

In the Driver Version drop-down list a.  Select the driver. 

b.  Click Accept. 
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If the driver is...  

Not in the Driver Version drop-down list a.  Click Add. 

b.  Browse to select the driver. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

   

4 Download All Content (page 31) to the controller. 
  

NOTE  You can click Delete Unused in the Controller section to delete all unused drivers in i-
Vu_Tools_x.x\webroot\<system_name>\drivers. 

 

 
 

Working with screen files in the Field Assistant interface 

To use an Equipment or System Touch, or BACview®, to view or edit a controller's property values, you must 
download a screen file (.touch, .bacview, .S37, or.kpd) to the controller.  

 

 
 

To select a different screen file 

1 On the Field Assistant navigation tree, right-click the controller, then select Driver Properties > Update tab. 

2 If other controllers in the system use the current screen file, select which controllers you want to change.  
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3 Do one of the following: 
  

If the screen file is...  

In the Screen file drop-down list a) Select the file.  

b) Click Accept. 

Not in the Screen file drop-down list a) Click Add. 

b) Browse to select the screen file. 

c) Click Open. 

d) Click Continue. 

e) Click Close. 

f) Click Close again. 

   

4 Download All Content (page 31) to the controller. 
  

NOTE  You can click Delete Unused in the Screen File section to delete all unused screen files. 

 

 
 

To edit a screen file 

You can obtain a screen file from the Field Assistant application, edit it, and then replace it in your Field Assistant 
application. 
  

To obtain the screen file for editing 
1 On the Field Assistant navigation tree, right-click the controller that uses the screen file, then select Driver 

Properties > Update tab. 

2 Under Screen File, click Edit. 

3 Click Save. 

4 Browse to the folder you want to put the file in. 

5 Click Save. 

6 Click Close. 
  

To add the edited file back in the Field Assistant system 
1 On the Field Assistant navigation tree, right-click the controller that uses the screen file, then select Driver 

Properties. 

2 Under Screen File, click Add. 

3 Browse to select the file. 

4 Click Open. 



 

 
 

Field Assistant v7.0 Carrier Proprietary and Confidential CARRIER CORPORATION ©2018   
Help  All rights reserved 
 30 

 

5 Click Continue. 

6 Click Close. 

7 Click Close again. 

 

 
 

BACnet device tools and services 

The tools and services described below let you control or troubleshoot BACnet devices. To access the tools and 
services, click on the BACnet router on the Field Assistant navigation tree, then click Properties. 
  

Tool Description 

Module Status Generates a Modstat report. See Using a Modstat to troubleshoot your system (page 88). 

Show Bindings Displays all Device IDs that the BACnet device communicates with and the network 
address of each device.  

  

BACnet device services 
Although the following BACnet device services can be used for Carrier controllers, you should not need to use them 
for this purpose. Their primary target is a third-party device that supports these services.  
  

Service Description 

Time Sync   

UTC Time Sync 

Sends the site's local time to the BACnet device. 

Sends the Coordinated Universal Time (UTC) to the BACnet device. The device must be 
able to convert the time to its local time zone. 

NOTE  Some devices support only one of the above time sync services. 

Backup, Restore, 
and Abort 

Executes a BACnet Backup or BACnet Restore service as defined by the BACnet 
standards. A message appears when the backup or restore is complete. 

Click Abort to stop a Backup or Restore. 

NOTE  These services are vendor-specific and should be used with caution. A failed 
restore could make a device inoperable. Before using these on a device running in a live 
system, test them on the device during installation.  

BACnet Password Applies to Backup, Restore, Warmstart, and Coldstart.  Enter your BACnet password if 
required by the BACnet device. This password is typically defined in a third-party tool. 

Warmstart or 
Coldstart 

Restarts the BACnet device.  

For a third-party device, see the manufacturer's documentation to determine the 
difference between these 2 services. 

For Carrier controllers, these services are the same. These services will cycle the 
controller's outputs. 

DCC Use to stop or start the BACnet device's communication. Select one of the following 
options in the droplist, then click DCC. 
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Service Description 

 Enable Starts the device's communication. 

 Disable  Stops the device's communication for the amount of time that you 
enter in the Timeout field. See NOTE below. 

 Disable 
Initiation 

Stops the device from initiating communication for the amount of time 
that you enter in the Timeout field. See NOTE below. The device will 
continue to respond to communications from other devices. 

 NOTE  Type -1 in the Timeout field to disable communication indefinitely. Normal 
communication will resume only when the device receives an Enable command. 

Event Info Displays detailed information about the objects that are currently in alarm. 

Event Summary Displays summary information about the objects that are currently in alarm. 

 

 

 
 

Downloading to controllers 

If you make any of the following changes, you must download the new data from the Field Assistant application to 
the affected controllers.  
  

In the Field Assistant 
interface 

• Change or reload a control program 
• Change or reload a driver 
• Change a schedule 
• Change a BACview® or touchscreen file 

  
The Field Assistant application automatically marks the affected controllers as requiring a download. You can 
download these controllers from the the Devices (page 32) page or the Properties (page 33) page for the 
controller, the equipment, or a microblock.  

When the Field Assistant application marks a controller for download, it determines what information needs to be 
downloaded based on the type of information that changed. See Download Options (page 32). 
  

By default, Full Source files are downloaded to i-Vu® PIC controllers because Optimize download for Open PIC 

controllers is unchecked on the Devices > Advanced tab (from the System  in the navigation tree). Check this 
option if you do not want Full Source downloaded. 

 CAUTION  If you want this option checked and purposely had it checked in your previous system, it is 
automatically unchecked after upgrading and you must check it again. 

NOTE  A property change in the Field Assistant interface is automatically downloaded to the controller.  
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Download Options 

When Field Assistant marks a controller for download, it determines what information needs to be downloaded 
based on the type of information that changed. Below are the options that can be downloaded. 
  

This option... Downloads... 

All Content •  Control programs  
•  Graphics  
•  Drivers  
•  Screen files 
•  Parameters 
•  Schedules 
  

NOTE  An All Content download also: 
•  Synchronizes the controller's time to Field Assistant 
•  Overwrites trends in the controller 
•  Restarts the controller 

Only Schedules All schedules that are not set for automatic download 

Only Parameters All editable properties 

Only BBMDs BBMD tables (.bdt file) that you have updated but have not yet written to the controller 

 

NOTE  An All Content download clears trend, history, and alarm data from the affected controllers.  

 

 
 

To upload or download parameters only 

This option uploads all editable properties from the device, but not the source files. If you edit the properties on a 
controller that is not physically connected to the computer, you will have to either upload or download parameters 
when you connect again. Upload to get what is in the controller into Field Assistant or download to send your 
changes in Field Assistant to the controller.  

 

 
 

To download from the Devices page 

The System  Devices page > Manage tab shows all of the routers that Field Assistant marked for download.  

A router's Devices page > Manage tab shows any controller or control programs that are under that router that 
Field Assistant marked for download.   
  

To download: 

1 On the navigation tree, select the System  or a router. 

2 On the Devices > Manage tab, view the list that Field Assistant marked for download and select them. 

NOTE Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers. 
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3 Click Download. A message appears This will download programs and other content for the entire controller 
and restart it. Are you sure you want to do this?  

4 Click OK. 

5 Repeat for each router. 
   

NOTES 

• Active uploads  and downloads  cannot be stopped. 
• Icons in the Status column indicate the following: 

  

 Active—Field Assistant is uploading to the controller. 

 Active—Field Assistant is downloading to the controller. 

 Pending—You initiated the download, and the controller is waiting for its turn to download. 

 Failed—The download failed. See If a controller fails to download (page 33). 

 On Hold—Indicates you clicked Hold to stop a pending  download. 

 

Click  in the upper left-hand corner to view a log of download activity in the current session. Copy to Clipboard 
lets you copy the text to paste it into another application. 

 

 
 

To download from a Properties page 

If a controller requires a download, a red download message and a Download button appear at the top of the 
Properties page for the controller, the equipment, or a microblock. Click the button to start the download. 

Downloading from the Properties page downloads All Content to the controller. 

 

 
 

If a controller fails to download 

A controller that fails to download appears on the Devices page > Manage tab with this icon .  

1 Review the reason for the failure: 

○ Hold your cursor over the failed task to see hover text giving the reason.  

○ Click  or  in the upper left corner of the page to see information on all failed downloads. Copy to 
Clipboard lets you copy the text to paste it into another application. 

2 Correct the problem that caused the failure. 

3 On the navigation tree, select the System  or a router, then click Devices. 

4 Select the controller that you want to download. 

NOTE  You must be connected to the controller to download. 
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Checking controller status 

On the Field Assistant navigation tree, you can select the System  to view the following for your routers or 
select the router to see the the following for controllers, then click Devices to: 

• View the status of the devices (page 34) 

• On the Manage tab, you can view information such as address and model. On the Advanced tab, you can view 
the driver and device ID. 

• Download or upload to resolve a mismatch (page 36) 

   

 

 
 

Status messages 

On the Devices page > Manage tab, the Status column shows a description of the current state. Hold your cursor 
over the Status description to see hover text with a more detailed description. If multiple conditions exist, Field 
Assistant displays the message with the highest priority.  

To see the Status messages: 

• On the Field Assistant navigation tree, select the System  to view the status of routers.  

• On the Field Assistant navigation tree, select a router to view the status of its controllers.  

 

The table below shows all possible messages. The message color indicates the following: 

Black—In process 
Red—An error occurred 
Blue—Requires action from the user 

 

Status column message Hover text message  Notes 

   

Black messages:   

Downloading The controller is downloading, 
communications may be disabled 

 

Uploading The controller is uploading, 
communications may be disabled 

 

Pending This controller is waiting to be processed.  

   

Red messages:   

Communications Error Cannot communicate with this controller.  
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Status column message Hover text message  Notes 

Connection Disabled The connection for this controller has been 
disabled. 

Occurs if someone stopped the 
connection.  

Connection Error The connection for this controller failed to 
start. 

Occurs if the connection is 
misconfigured or failed to start. 

Controller Disabled This controller has been disabled.  

Controller offline The controller is offline.  

Download Failed (Message depends on the cause of the 
failure.) 

 

Download Not Permitted This controller is not permitted to 
download. 

 

Error  An unknown error has occurred.  

Missing Files Upload failed. Server is missing source 
files. 

 

Not Uploadable  This controller is not configured for 
content upload. 

Occurs if you attempt to upload a 
controller with a pre-4.x driver. 

Out of Service This controller is out of service. Out of Service is checked on the 
controller's Properties page. 

Unsupported Controller This controller does not support content 
upload. 

 

Upload Not Permitted This controller is not permitted to upload.  

   

Blue messages:   

Controller Replaced This controller has been replaced by 
another controller of the same type in the 
field. 

 

Download All Content Please download all content to the 
controller. 

 

Download Parameters To download parameters, highlight row 
and select "Only Parameters" from the 
Download Action menu and click 
"Download" 

 

Download Schedule To download schedules, highlight row and 
select "Only Schedules" from the 
Download Action menu and click 
"Download". 

 

Driver Parameter 
Mismatch 

Driver parameter differences detected. 
Upload parameters from the controller or 
download parameters to the controller. 

 

Network Ready to Find 
Devices 

To upload this network, select the router in 
the tree and click Find Devices button. 
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Status column message Hover text message  Notes 

Parameter Mismatch Control Program parameter differences 
detected. Upload parameters from the 
controller or download parameters to the 
controller. 

See Handling parameter mismatches 
(page 36). 

Program Mismatch Content differences detected. Upload all 
content from the controller or download all 
content to the controller. 

 

Unprogrammed 
Controller 

This is a programmable controller. To add 
control programs, click Add Control 
Program. 

 

Upload All Content Please upload all content from the 
controller. 

 

   

General messages:   

 This controller is ok.  

Cancelled  The last operation on this controller was 
cancelled 

 

 

 
 

Handling parameter mismatches 

A parameter mismatch occurs when a value in a controller does not match the value in the system database. This 
can be a driver or control program value.  

To find mismatches in your system 
You can find mismatches in the following places: 

• The Devices page > Manage tab > Status column will show Parameter Mismatch. 

• The Properties page for a controller, driver, control program, or point will show one of the following red 
messages at the top of the page stating: 

Control Program parameter differences detected. 
Driver parameter differences detected. 
Parameter download required. 
 
The value that has a discrepancy will appear with a purple box around it. Hover your cursor over the field to 
see: 

  

or 
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To resolve a mismatch 
1 Go to one of the following:  

• Devices page - Click the Parameter Mismatch link 
• Properties page that shows one of the red messages above 

  
2 Click one of the following: 

○ Resolve to let the Field Assistant application download changes made in the Field Assistant interface or 
upload changes made in the controller. Click the Details button to see what the discrepancy is and 
whether Resolve will download or upload parameters. See NOTE below. 

 

○ Upload to upload the parameters from the controller to the Field Assistant application 

○ Download to download the parameters from the Field Assistant application to the controller 

  
NOTE  On the Devices page with Show Control Programs unchecked, if a controller has simultaneous 
mismatches in the driver and control program, clicking Details will show that a control program mismatch 
exists but it will only show details for the driver mismatch. You must go to the control program in the tree to 
see details of that mismatch. However, clicking Resolve will resolve both mismatches. 

  

 

 
 

Managing setpoints 

The Setpoint graphic shown on a standard equipment graphic indicates the base setpoint values (Occupied 
High/Low, Unoccupied High/Low). The Field Assistant application reads these values back periodically, typically 
within 10 seconds. The timing can vary based on network traffic, the number of controllers in the database, and 
several other variables. Setpoints that are changed in the field via another user interface are displayed in the Field 
Assistant interface as soon as they are detected.  

You can, at any time, change the setpoints from Field Assistant graphics by using the slider or by entering numeric 
values directly. Updated setpoints are transmitted to the controller when you Accept the changes. Setpoints can 
also be changed on the Properties page > Control Program tab > Space Temperature and Setpoints. or 
Configuration > Setpoints. 

The various color bars indicate adherence to or deviation from the setpoint. You can change the current default 
settings for setpoint deviation. Select a color band on the setpoint graph to see the current setpoints in the 
Heating and Cooling fields. The values in this graphic are Fahrenheit. See setpoint descriptions below. 

NOTE  This graphic is an example only. Your setpoints may differ. 
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Color  Condition 

 Green Temperature is within the Occupied Low and High Setpoint 

 Grey Temperature is within the Unoccupied Low and High Setpoint 

 Light Blue Temperature is less than 2°F below the Occupied Low Setpoint  

 Dark Blue Temperature is more than 2°F below the effective Low Setpoint but less 
than 4°F below the effective Low Setpoint 

 Yellow Temperature is less than 2°F above  the effective High Setpoint 

 Orange Temperature is more than 2°F above the effective High Setpoint but less 
than 4°F  above the effective  High Setpoint 

 Red Temperature is more than 4°F above or below the effective setpoints   
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Adjust setpoints 

• Programmed setpoints are set and changed by operators.  

• Effective setpoints reflect the impact of other system conditions on the programmed setpoints, such as 
setpoint adjustments, and hysteresis. Effective setpoints control the equipment.  

 

To change programmed setpoints: 

1 Navigate to a setpoint control in one of the following places: 

○ Properties page > Control Program tab > Configuration > Setpoints 

○ The setpoint microblock pop-up on a Logic page 

○ A Graphics page (Click a setpoint trend graph control to access the editable setpoint bar.) 
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2 Make changes on a programmed setpoint bar by either:  

○ Clicking and dragging the segment or the gap between segments  

○ Typing new values in the Heating and Cooling fields 

3 Click Accept. 

 

 
 

Demand Control 

Demand Control is a cost-saving strategy that saves energy while maintaining comfort in the following ways: 

• Controlling energy use to avoid peak demand, ratchet, or time of use utility charges 

• Maintaining ventilation at relaxed setpoints rather than shutting down equipment (as with load shedding or 
duty cycling) 

Before you can use Demand Control effectively, you must: 

• Obtain details regarding past energy usage and peak demand, ratchet, and time of use charges from your 
energy provider. 

• Understand the demand profiles of the zones you are controlling. 

Demand Control can be customized at the zone level. For example, you may relax the setpoints in some zones, like 
break rooms and closets, by a few degrees, but you may not want to relax setpoints in computer rooms at all. 

  

 

  

To define Demand Control properties 
1 On the navigation tree, select the electric meter. 

2 Select Properties > Control Program and expand the Demand Level Parameters section. 

3 Type the Start and End time to define the time period that you want demand control to be in effect for this 
zone. 

4 Type kilowatts per hour (kW/hr) in the Level columns to define the amount of power that the demand must 
exceed before the Field Assistant system calls for a higher demand level. 
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NOTE  Levels are defined in the electric meter control program in the Snap application. You can test the Demand 
Levels by locking the meter to a value. 

In the example below, during Period 4, defined as 12:00 (noon) to 16:00 (4:00 p.m.), if the demand exceeds 800 
kW/hr, the Field Assistant system will use Demand Level 1 setpoints. If the demand exceeds 1000 kW/hr, the 
Field Assistant system will use Demand Level 2 level setpoints and so on. 

 

 
 
 

Configuring Optimal Start 

Enable and configure Optimal Start on the  Properties page > Control Program tab > Configuration > Setpoints. 
Your control program could be configured for Optimal Start or for both Optimal Start and Optimal Start Type.  

NOTES 

• The Optimal Start options depend on the revision date of the control program in your controller. 

• Optimal Start is automatically disabled when Properties > Control Program > Maintenance > Occupancy > 
BAS On/Off is set to either Unoccupied or Occupied.  

 
 

Optimal Start 

Optimal Start adjusts the effective setpoints to achieve the occupied setpoints by the time scheduled occupancy 
begins.The Optimal Start recovery period may begin as early as 4 hours prior to occupancy. The algorithm works by 
moving the unoccupied setpoints toward the occupied setpoints. The rate at which the setpoints move is based on 
the outside air temperature, design temperatures, and capacities. 

The following conditions must be true for optimal start to operate: 

• On the Properties page > Control Program tab > Configuration > Setpoints > Optimal Start, the Default Value 
must be set greater than 0 and less than or equal to 4 (0.00 disables Optimal Start). 

• The system is unoccupied 

NOTE  If the Open controller does not have a valid outside air temperature, then a constant of 65° F is used. This 
value is not adjustable. 
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The actual equation that the controller uses to calculate Optimal Start is nonlinear. An approximation of the result 
is shown below. 

 

 
To change Optimal Start settings: 

1 In the navigation tree, select the equipment that you want to change. 

2 Select Properties page > Control Program tab >  Configuration > Setpoints. 

 

 
 

Optimal Start Type 

If you have Optimal Start Type, you must choose from the following: 

• None 

• Temperature Compensated Optimal Start 

• Learned Adaptive Optimal Start 

 
To select the method used to change from unoccupied to occupied setpoints: 

1 In the navigation tree, select the equipment that you want to change. 

2 Click Properties page > Control Program tab >  Configuration > Setpoints. 

3 Select option from the Optimal Start Type drop-down list. 

4 See below to make further adjustments. 

 
None – The unit will not start to control to the occupied setpoints until the unit goes into an occupied mode. 
Setpoints do not ramp, but change immediately from unoccupied to occupied values. When you select None, you 
must set all Learning Adaptive Optimal Start transition factors, identified by their themographic color, to 0. These 
are located directly above the Effective Set Points graph.   
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Temperature Compensated – The unit changes to occupied setpoints at some time prior to the occupied time, not 
to exceed the hours you set for Optimal Start. The start time is determined by the current error between space 
temperature and the appropriate heating or cooling setpoint. At that time, the setpoints do not ramp, but change 
immediately from unoccupied to occupied values. When selecting Temperature Compensated, you must set all 
Learning Adaptive Optimal Start transition factors, identified by their thermographic color to 0. These are located 
directly above the Effective Set Points graph.  

When selecting Temp Compensated, you can adjust the following: 

• Heat Start K factor (min/deg) – If Optimal Start Type is Temp Compensated, this is the time in minutes per 
degree that the equipment starts before the occupied period when the space temperature is below the 
occupied heating setpoint (including any setpoint offset).  

• Cool Start K factor (min/deg) – If Optimal Start Type is Temp Compensated, this is the time in minutes per 
degree that the equipment starts before the occupied period when the space temperature is above the 
occupied cooling setpoint (including any setpoint offset).  

NOTE  The default value for the above is 15.00 and the range is 0 to 99.  

 

Learning Adaptive Optimal Start – This function gradually adjusts the unoccupied setpoints over a specified period 
of time to achieve the occupied setpoint by the time scheduled occupancy begins. This learning adaptive algorithm 
uses the learned heating capacity and learned cooling capacity values to calculate the effective setpoints prior to 
the occupied start time. The algorithm calculates a learned cooling and heating capacity during the previous 
unoccupied time. Set the Learning Adaptive Optimal Start recovery period from 1 to 4 hours in Optimal Start. 
When the Learning Adaptive Optimal Start routine runs, adjustments are based on the color that is achieved when 
occupancy begins. Adjustment amounts are defined in the thermographic color fields located directly above the 
Effective Setpoints graph under Setpoints. 

EXAMPLE  The heating capacity for a zone is 5° per hour (default). When the zone becomes occupied, the zone 
temperature is 1° below the occupied setpoint, indicating a need for additional heat. Because the zone 
temperature was low by 1°, the learned heating capacity is decreased by the value entered in the LtBlue 
thermographic color field (0.0600 default). As a result, the learned heating capacity is adjusted to 4.94° for the 
next optimal start period. Since the algorithm has calculated that the equipment has less capacity to bring the 
temperature to setpoint within the configured recovery period, the setpoint adjustment  begins sooner in the next 
unoccupied period. 

To change the adjustment values in the Learning Adaptive Optimal Start routine: 

1 In the navigation tree, select the equipment that you want to change. 

2 Click Properties page > Control Program tab > Configuration > Setpoints. 

3 Adjust the color fields between the Zone Setpoints graph and the the Effective Setpoints graph. 

  
When you determine that no further start time optimization is required, you can disable Heating and Cooling 
Capacity adjustments by setting the color field values to 0.0. 

You can reset the learned heating and cooling capacities by entering a value into either the Heating Capacity or 
Cooling Capacity, located beneath the Zone Setpoints graph.   
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 CAUTION  When using Learning Adaptive Optimal Start, be sure that all equipment is properly maintained so 
that your system does not “learn” to compensate for dirty filters or loose fan belts. 
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Commissioning equipment 

Follow the process below to commission system equipment. 

 

 
 

Step 1:  Check out point setup 

1 On the Field Assistant navigation tree, select the piece of equipment you want to check out. 

2 Click Properties. 

3 View and change properties on the I/O Points, Alarm Sources, Trend Sources, Network Points, BACnet 
Objects, and Rnet Points tabs. See "Property descriptions" below. Tabs may or may not appear, depending on 
the control program. 

4 Select Checked Out. This field is for your reference only. 

5 Optional: Type Checkout Notes if desired. Notes remain in this field until an operator deletes them. 

6 Optional: Click the Reports drop-down arrow, then select and run each of the following reports to verify your 
work: 

○ Equipment > Point List 

○ Equipment > Network IO 

○ Alarms > Alarm Sources 

  

 TIP  You can export the calibrated data so that you can import it into another control program. See Optional: 
Import/export calibration data (page 51). 

  

Property descriptions 

I/O Points 
Name Click the name to display the microblock pop-up. 

NOTE  A red name indicates a fault condition where the point may be misconfigured. 
EXAMPLE  No input/output number or a nonexistent input/output number. 

Type Type of Input or Output point. See Point types (page 58). 

Value The point's present value. 

Offset Allows for fine calibration of the present value of an analog point. 

Polarity Determines the point’s binary normal polarity in the control program. 
NOTE  Polarity is not the hardware normally open/normally closed position. 

Locked Select the checkbox to lock the present value at the value you specify. 

Exp:Num Expander numbers and input or output numbers associated with where the physical point 
wires, such as a sensor wire, are physically connected to a controller. 

I/O Type Selects the bank of physical inputs or outputs on the controller. 
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Sensor Selects how the physical input is mapped to the engineering units. 

Min/Max is used with the sensor type of linear to scale the input to engineering units. 
NOTE  This field is ignored for sensor types other than linear. 

 EXAMPLE: AI linear sensor type 
min 
max 

  
-10 
50 

  

  when input reads 100% 
50% 
0% 

the value is 50 
20 
-10 

Actuator Selects how the present value in engineering units is mapped to the physical output.  

Min/Max is used with the actuator type of linear to scale the output from engineering 
units. 
NOTE  This field is ignored for actuator types other than linear. 

 EXAMPLE: AO linear sensor type 
min 
max 

  
-10 
50 

  

  when input reads 50 
20 
-10 

the output is 100% 
50% 
0% 

Resolution Amount by which the present value will change.  
EXAMPLE  If a physical input changes by 1, but the resolution is set at 2, then the present 
value remains the same. If the input changes by 2, the present value will then change by 
2. 

Checked Out 

Checkout Notes 

These fields are for your reference only. 

 

Alarm Sources 
Name Click the name to display the microblock pop-up. 

Type Type of point that is an alarm source. See Point types (page 58). 

Alarm Shows Alarm in red if a current alarm exists.  

Network Visible Select to allow the microblock to be seen by the Field Assistant application and third-party 
BACnet controllers on the network. 

Potential alarm 
source 

Select to enable the microblock to generate alarms. 

Alarm Enabled Alarm—Select to generate an alarm when conditions exceed the limits set in the Condition 
column. 
Return—Select to generate a return-to-normal message when the alarm condition returns 
to a normal state.  
Fault—Select to have an alarm generated if the alarm source is not configured correctly. 
For example, a misconfigured channel number produces a no sensor fault. 

Requires ack Alarm—Select to require that the alarm be acknowledged. 
Return—Select to require that the return-to-normal message be acknowledged. 
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Critical Select if the alarm is critical. 

Category You can change the alarm category assigned to the microblock. 

Condition An alarm will be generated if conditions exceed the low or high limits set.  

Deadband: 
The amount inside the normal range by which an alarm condition must return before a 
return-to-normal notification is generated. 

EXAMPLE 

 

Delay Delay time in seconds for notification after an alarm is generated. 

  

Trend Sources 
Name Click the name to display the microblock pop-up. 

NOTE  A red name indicates a fault condition where the point may be misconfigured. 
EXAMPLE  No input/output number or a nonexistent input/output number. 

Type The type of point being trended. See Point types (page 58). 

Sample Interval The interval or COV (Change of Value) increment that triggers the trend sample. 

 

Network Points 
Name Click the name to display the microblock pop-up. 

NOTE  A red name indicates a condition where the point may be misconfigured. 

Type Type of network point. 

Value The point's present value.  
EXAMPLE  For a Maximum point type, Value is the maximum value of all the target BACnet 
object properties the point is communicating with. 

Locked Select the checkbox to lock the present value at the value you specify. 

Default Value The value that the control program will use as the point’s value when communication with 
the target defined in the Address column is lost or communication is disabled. 

Com Enabled Select to enable this point’s network communications. Disable this property for 
troubleshooting. 

NOTE  Select All in the column header to quickly enable all points in the control program. 



 

 
 

Field Assistant v7.0 Carrier Proprietary and Confidential CARRIER CORPORATION ©2018   
Help  All rights reserved 
 48 

 

COV Enable Select to make: 

• A digital network output point write a value to the target defined in the Address 
column only when the value changes. 

• An analog network output point write a value only when the value changes by the 
specified increment. 

Refresh Time 
(mm:ss) 

The time interval at which the network point writes or retrieves the value to or from the 
target. For network output points, this time is used when COV is not enabled or when COV 
is enabled but fails. 

NOTE  If COV fails and the Refresh Time is zero, the value is sent once per second. 

Address The address of the target BACnet object property or third-party value that the point 
communicates with. 

NOTE  Click Search/Replace at the top of the Address column to have the Field Assistant 
application replace all instances of specific text in the addresses with different text. This is 
especially useful when copying a control program to use for multiple third-party devices. 

Error The error code and error if the point cannot communicate with the target. 

Present Value Current value of the target defined in the Address column. 

Checked Out 

Checkout Notes 

These fields are for your reference only. 

 
Notes typed in this field appear in the Equipment Points List Report. 

 

BACnet Objects 
Name The name used in the Field Assistant interface for this object. Click the name to display 

the microblock pop-up. 

NOTE  A red name indicates a condition where the point may be misconfigured. 

Reference 
name 

A unique identifier that allows the point to be referenced for used for graphics, source tree 
rules, or network links.  

Type The BACnet object type.  

Present Value The object's current value. 

Locked Check to lock the third-party object to a specific value.  

Device A device alias. See "To reuse a control program" in Device Alias. 

Object Name An alpha-numeric string that is unique within the third-party device. 

Object ID A combination of the object type and a unique instance number. The object ID must be 
unique within the device. 

Address The address of the third-party object that the microblock references. 

Network Visible Allows other BACnet equipment to read or change the microblock's present value. Must be 
enabled for this microblock to generate alarms. 
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Rnet Points 
This tab shows varying information for the different point types. Below are all possible properties that may appear 
on this tab and a list of the applicable points. The following list is arranged alphabetically. 

 

Combination 
Algorithm 

(Analog Sensed Values) 
The method used to combine the ZS sensors' values to determine the microblock's 
output value. 

Default Value (Analog Parameters, Binary Parameters, Multi-State Parameters) 
The value the control program uses until a user changes the value in the system 
interface. 

Display 
Resolution 

(Analog Sensed Values, Analog Statuses, Analog Parameters) 
Defines the resolution of the value to be displayed on the ZS sensor.  For example, 1 
displays only integers (example: 74) and 0.5 displays values to the nearest 0.5 (example: 
74.5). 

Edit Increment (Analog Parameters) 
The amount that you want each press of the sensor's  or  button to change the 
microblock's value. 

Editable (Analog Parameters, Binary Parameters) 
When enabled, the microblock's value is editable on the ZS sensor. 

Lock Present 
Value to 

(Binary Parameters) 
Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Maximum (Analog Parameters) 
The highest amount that this value can be changed to on the ZS sensor or in the Field 
Assistant interface. 

Menu 
Configuration 

(All points) 
Shows which sensor screens display the value. 

Minimum (Analog Parameters) 
The lowest amount that this value can be changed to on the ZS sensor or in the Field 
Assistant interface. 

Minimum off 
time 

(Binary Parameters) 
The minimum period (seconds) that the microblock sends an off signal to the controller, 
regardless of the input signal to the microblock. 

Minimum on 
time 

(Binary Parameters) 
The minimum period (seconds) that the microblock sends an on signal to the controller, 
regardless of the input signal to the microblock. 

Object Id (All points) 
A combination of the object type and a unique instance number. 

Object Name (All points) 
A unique alphanumeric string that defines the BACnet object. Although the Object Name 
field can be edited, it is not recommended. 

Reference name (All points) 
A unique identifier that allows the point to be referenced for used for graphics, source 
tree rules, or network links.  
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Rnet Tag (All points) 
Defines what type of information this value represents and determines how the sensor 
will display the value. For example, for the Rnet Tag Fan Status, the sensor automatically 

displays  on the Home screen when the microblock is active.   

Show on sensors (Analog Sensed Values) 
Defines whether the ZS sensors are to display their individual sensed values, or the value 
determined by the Combination Algorithm. 

Type (All points) 
Type of Input or Output point. See Point types (page 58). 

Value (All points) 
The point's present value. 

 

Protocol Mapping 
If a control program was built with Protocol Mapping information in Snap, this tab will appear showing third-party 
protocol configuration information. 

 

 
 

Step 2: Check controller to sensor wiring 

PREREQUISITE  On the Logic page, disable the run condition(s) in the control program to prevent control program 
execution from affecting output values while you check out the equipment. 
  

Binary inputs (BI) 
1 Short the binary inputs wires at the end device, for example, at a pump proof or fan proof. 

2 On the Properties page I/O Points tab, verify the binary input point is closed. 

3 Open the binary input at the end device. 

4 Verify the binary input point is open on the Properties page. 

5 Repeat for all binary inputs. 

NOTE   If the readings on the Properties page are reversed from actual conditions, the polarity (normally 
closed/normally open contact position) is set incorrectly. 
  

Analog inputs (AI) 
1 Verify the sensor type and the min/max values are configured correctly. 

2 On the Properties page I/O Points tab, read the analog input value. 

3 Short the point. The sensor should go to full range when shorted. 

4 Calibrate analog input value by adjusting the calibration offset if needed. 
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Binary outputs (BO) 
1 If the controller's binary output is wired through an equipment starter, set the starter HOA switch to Automatic. 

2 On the controller, set the binary output’s HOA switch to On. 

3 Verify that the controlled equipment has turned on. 

4 On the controller, set the binary output’s HOA switch to Automatic. 

5 On the Properties page I/O Points tab, lock the binary output point to On. 

6 Verify the device has turned on. 

7 Unlock the binary output point. 

8 On the controller, set the binary output’s HOA switch to Automatic. 

NOTE   If the locked conditions on the Properties page are reversed from actual conditions, the polarity (normally 
closed/normally open contact position) is set incorrectly. 
  

Analog outputs (AO) 
1 Verify the output/actuator type and the min/max values are configured correctly. 

2 Lock the analog output point to the device minimum output, such as 2 volts or 0%. 

3 Verify movement of the end device to the desired position. 

4 Lock the voltage output to the device maximum, such as 10 volts or 100%. 

5 Verify movement of the end device to the desired position. 

6 Unlock. 

 

 
 

Step 3:  Check equipment operation 

Refer to the sequences of operation in the system specifications to verify that the equipment operates in each 
operational mode (for example, occupied and unoccupied) as specified. 

 TIP  If needed, you can import calibration data that you exported from another control program. See Optional: 
Import/export calibration data (page 51). 

 

 
 

Optional: Import/export calibration data 

You can export I/O point calibration data from a control program and import it into the same control program or 
another control program with the same I/O point configuration. 

To export calibration data 
1 On the Field Assistant navigation tree, select the control program whose data you want to export. 

2 Scroll to the bottom of the Properties page I/O Points tab, and then click Export. The file <control program 
name>_<ref name>.xml is saved in your browser's Downloads folder. 
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To import calibration data 
NOTE  We recommend that you export existing data as a backup before you import new data. 

1 On the Field Assistant navigation tree, select the control program that you want to import the data into. 

2 Scroll to the bottom of the Properties page I/O Points tab, and then click Import. 

3 Browse to the file you want to import. 

4 Click Continue. A side-by-side comparison of existing data and the new import data will appear. Red text 
indicates one of the following errors: 
• Duplicate data—Existing data has duplicate I/O numbers so that import cannot determine its match. 
• I/O type mismatch—I/O Type in existing data does not match I/O Type in import data. 
• Missing import data—Existing data has a point that import data does not have. 
• Missing system data—Import data has a point that existing data does not have. 

5 Click OK to complete the import. Existing data that does not show an error will be overwritten by the imported 
data. 

 

 
 

Adjust airflow configuration for VAV or VVT controllers 

To enter airflow parameters for a VAV Zone, VVT Zone or VVT Bypass controller, right-click on the controller in the 
navigation tree and select Airflow Config in the menu.  

For more information, see the following microblock details. 

• VAV Zone, VAV Zone II, Zone Ctrl, VAV Zone II Secondary Duct - Airflow Control  

• VVT Zone, VVT Zone II - PD Airflow Control 

• VVT Bypass, VVT Bypass II - BACnet Bypass Control 

 

 

 
 

Graphics pages 

Field Assistant can upload and display multiple graphics (.views) that were downloaded to a controller. But Field 
Assistant can download only a single .view to the controller. If you edit one of the .views and download to the 
controller, you will only download the edited .view. Information for the other .views will be removed from the 
controller. You can reattach and redownload those .views from your i-Vu® system. 

You can view and adjust your system from Graphics pages. 

Some typical controls that may appear on a graphics page are: 

• Button or switch to turn equipment on or off 

• Input field to set a property value 

• Drop-down list to select a state 
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• Interactive room sensor to override an unoccupied schedule 

• Setpoint graph to adjust setpoints 

• Trend graph to view trend information 

• Link to jump to another Field Assistant page   

 

NOTES 

• Right-click a value, then select Details to view and change properties in the microblock pop-up.   

• Right-click a value, then select Global Modify (page 59) to view and change the property in other control 
programs.   

• A yellow dashed line indicates a value that is forced or locked.  

• If a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the action pane. 
Select Scale to Fit again to return the graphic to its original size. 

 

 

 
 

To attach a graphic in the Field Assistant interface 

1 On the navigation tree, right-click the item that you want to attach a graphic to, then select Configure. 

2 Do one of the following: 
  

If the graphic is...  

In the Graphic Page drop-down list a.  Select the graphic. 

b.  Click Accept. 

Not in the Graphic Page list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 

NOTE  You can click Delete Unused at the bottom of the Views section to delete all unattached graphic files 
from your system. 
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3 Equipment graphic only:  If the system has other control programs of this type, select which control programs 
you want to change.  

 

NOTES   

○ If the control program is in an IP router, the second option will change the graphic for all control programs 
of this type only on the IP network. 

○ If the control program is on the network below an IP router, the second option will not change the graphic 
for the router's control programs of this type. 

 

 

 
 

To edit a graphic from the Field Assistant application in ViewBuilder 

1 In the Field Assistant interface, double-click the controller in the navigation tree or right-click and select 
Configure. 

2 Click Edit Existing button under Views. 

3 Click Save as and place the file in an appropriate folder. 

4 Open ViewBuilder. 

5 Select File > Open.  Browse to your saved graphic and click to open. 

6 Edit and save with a new name - the original system name is locked and cannot be used for an edited graphic.  

NOTE  Names are case sensitive and should not have spaces and/or special characters. 

 

 

 
 

To control equipment using an interactive zone sensor 

An equipment graphic may include an interactive zone sensor that provides you with the following control.  

 

If the sensor is a...      You can... 
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If the sensor is a...      You can... 

ZS  

 
  

  
• Click  to raise the setpoint or  to lower the setpoint.  

• Click    to override the schedule and put the zone in an occupied state. 
To cancel an override, continue clicking  until the display shows 0. 

• See that the zone is in an occupied state when the green LED is lit. 

 

SPT Standard, Plus, or Pro  

 

  
• Click the WARMER or COOLER button to adjust the setpoint.  

• Click the MANUAL button to override the schedule and put the zone in an 
occupied state. 

• Click the INFO button to cycle through the following information: 

• Outside air temperature, if enabled in the control program 

• Override time remaining 

• Heating setpoint 

• Cooling setpoint 

• See the Occupied/Unoccupied state in the display. 
  

SPT Pro Plus  

 

  
• Click the WARMER or COOLER button to adjust the setpoint.  

• Click the MANUAL button to override the schedule and put the zone in an 
occupied state. 

• Click the INFO button to cycle through information such as: 

• Outside air temperature 

• Override time remaining 

• Heating setpoint 

• Cooling setpoint 

• Click the FAN button to adjust the fan speed. 

• Click the MODE button to perform customer-specific functions. 

• See the Occupied/Unoccupied state in the display. 
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Copying properties from one controller to another 

You can copy a control program's properties to other controllers that use the same control program. You do not 
have to be physically connected to the controller that you are copying from. But, to download copied properties to a 
controller, you must be connected to it or to the network that the controller resides on. 

1 On the navigation tree, right-click the controller that has the properties you want to copy, then select Copy 
Control Program Properties and click OK. 

2 In the Global Copy dialog box, check Embedded Trend Graph Settings and All editable properties.  

 

3 Click Search. 

4 Do one of the following: 

○ Check Skip bad values to copy all values except a bad value (the hardware differs, a property to be 
copied is undefined, etc.).  

○ Uncheck Skip bad values to prevent any values from being copied if a bad value is found. 

5 Click Apply Changes, then close the dialog box.  

NOTE  If a message appears Copy process complete, but some values were not copied, click OK. Field Assistant 
displays a list of parameters that were not copied.  

 

 
 

Properties pages 

Properties pages are automatically generated from control programs. Properties pages show the status of a piece 
of equipment and the points/properties currently stored in it. See Check out point setup (page 45) for details. 

Use Properties pages to: 

• View the status of a piece of equipment.  See Colors and status in the Field Assistant interface (page 16).  

• View or change the equipment point/properties currently stored in the controller. 

• Commission equipment (page 45) 

• Set up Linkage. 

Refer to your individual controller's Installation and Start-up Guide for detailed explanations of the 
points/properties. 

 

 

 

 
 



 

 
 

Field Assistant v7.0 Carrier Proprietary and Confidential CARRIER CORPORATION ©2018   
Help  All rights reserved 
 57 

 

To view or edit properties on a Properties page 

1 Select a controller on the navigation tree, click Properties, and then select the appropriate tab. 

NOTE  You must resolve any condition described in red text at the top of the page before a Properties page 
can obtain current information from its controller. 

2 Click  to show property details. 

 

 

3 Do one of the following to change a property: 

○ Select or clear a checkbox 

○ Select an item on a drop-down list 

○ Change text in a text field 

4 Click Accept. 

NOTES  

• Click the bold, underlined point name to open the editable microblock pop-up 

• Right-click a value, then select Details to view and change properties in the microblock pop-up. 

• Right-click a value, then select Global Modify (page 59) to view and change the property in other control 
programs. 

• Use Search/Replace on the Network Points tab to replace a term in the point address with another address. 

•  For the legend of status colors, see Colors and status in the Field Assistant interface (page 16).  

• A yellow dashed box around a value indicates the value is locked or forced. 
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Point types 

A point name on the Properties page is followed by a code that tells you the point type. The table below describes 
each code. 
  

         

 

Code Point type 

AI Analog Input 

ANI Analog Network Input 

ANI2 Analog Network Input 2 

ANO Analog Network Output 

ANO2 Analog Network Output 2 

AO Analog Output 

ASVI BACnet Analog Sensed Value Input 

AV Analog Value 

BAI BACnet Analog Input 

BALM BACnet Alarm 

BAO BACnet Analog Output 

BAV BACnet Analog Value 

BBI BACnet Binary Input 

BBO BACnet Binary Output 

BBV BACnet Binary Value 

BFM Floating Motor 

BI Binary Input 

BMSV BACnet Multi-State Value 

BNI Binary Network Input 

BNI2 Binary Network Input 2 

BNO Binary Network Output 

BNO2 Binary Network Output 2 

BO Binary Output 
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Code Point type 

BPTA Pulse to Analog Input 

BPWM Pulse-Width Output 

BRS RS Sensor 

BRSF RS Sensor Fan 

BSVI BACnet Binary Sensed Value Input 

BTLO Timed Local Override 

BTRN Trend Log 

BV Binary Value 

DI Digital Input 

DO Digital Output 

EVT BACnet Alarm 

POLLAVG Average Analog Properties 

POLLMAX Maximum Analog Properties 

POLLMIN Minimum Analog Properties 

POLLTOT Total Analog Properties 

PTA Pulse to Analog Input 

TLO Timed Local Override 

 

 
 

Changing properties/points in multiple controllers at the same time 

Two Field Assistant features, Global Modify and Global Copy, allow you to view and change points or properties in 
multiple controllers at the same time. 

TIP  Click  to copy a reference path to the clipboard that you can use in ViewBuilder. 

 

 
 

To use Global Modify 

Use the Global Modify feature to: 

• View a microblock’s full path, control program name. 

• View or change a single property in several control programs at one time. 

• View errors on Graphics and Properties pages. 
  

1 Browse to any page that displays the property you want to view or change. 
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2 Do one of the following to access Global Modify.  
• Right-click the property, then select Global Modify. 
• Alt+click the property. 

3 Make changes to the Control Program field, if needed. 

NOTES 

○ Use wildcards in the Control Program field to broaden the search. 
For example: 

vav* matches vav, vav1, vavx, vav12345 

vav*z matches vavz, vav1z, vavxz, vav12345z 

vav*1*2 matches vav12, vavabc1xyz2 

vav?? matches vav11, vav12, vavzz, but does not match vav, vav1, vav123 

* matches any control program 

○ Click Show Advanced to view the location and value associated with this property. 
  

 
  

4 Select the tree item that you want to search under for every occurrence of that microblock in other control 
programs. 
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5 Click Find All. 

6 Select the properties in the list that you want to change. 

7 Do one of the following: 

a) Type a New Value a to the right of each selected item. 

b) Select Enable All, type a new value in b, then click Set All To. 

c) Select Enable All, type a new value in c, then click Change All By. 

 

 

8 Click Apply Changes. 

NOTE  To modify several properties in multiple control programs at the same time, use Global Copy. 

 

 
 

To use Global Copy 

Use Global Copy to copy any or all of the following from one control program to other equipment using the same 
control program: 
• Embedded trend graph settings 
• Custom trend graphs 
• Custom reports 
• Other editable properties to other pieces of equipment using the same control program. 

  
1 On the navigation tree, right-click the piece of equipment that has the properties you want to copy, then select 

Copy Control Program Properties. 

2 Click OK when you see This will copy this control programs properties to other control programs of the same 
type. Continue?. This opens the next screen and does not lock in any changes. 

3 In the Global Copy dialog box, select the items that you want to copy. 
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4 Select the area on the tree containing similar control programs that you may want to copy these properties to, 
then click Search. 

All instances at that level and below are listed in the expanded lower window. 

5 Check or uncheck items as needed. 

6 Do one of the following: 

○ Check Skip bad values to copy all values except a bad value (it cannot be copied because you do not 
have the necessary privilege, the property to be copied is undefined, etc.).  

○ Uncheck this field to prevent any values from being copied if a bad value is found. 

7 Click Apply Changes, then close the Global Copy dialog box.  

 

 
 

Logic pages 

The Logic page shows a custom control program for a programmable controller. The live data (yellow text) is 
updated every few seconds and when you click the Logic button. The control program uses exact property values 
for its calculations, but values are rounded to 2 decimal places when displayed on the Logic page. 

 TIP  Click anywhere on the Logic page, then use your keyboard's Page Up, Page Down, and arrow keys to scroll 
through the page. 

NOTE  If you find an unexpected value on a Properties page or a Logic page, you can use the Logic page to 
troubleshoot. 

 

 
 

To view a Logic page 

1 Select a custom control program on the navigation tree. 

2 Click Logic. 

3 Click a microblock to view its details. 

 

 
 

To locate a microblock, section, or label 

1 Right-click the Logic page, then select Jump To. 

2 Do one of the following: 

○ On the Microblock or Section tab, select an item to have it located and highlighted. 

○ On the Label tab, select a label to display a reduced logic page outlined in yellow that shows all instances 
of the label. A red box indicates an output label; a yellow box indicates an input label. Click a red or yellow 
box to jump to that label in the full-size logic page. 
 
NOTE  You can also click a label on the full-size Logic page to display the reduced Logic page.  
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To change properties, alarms, or trends 

1 Click a microblock on the equipment’s Logic page. 

2 In the microblock pop-up, click the Properties, Alarms, or Trends button. 

3 Change properties, alarms, or trends for that microblock in the same way that you would make changes on a 
regular Properties (page 56), Alarms (page 74), or Trends (page 69) page. 

4 Click Accept. 
  

NOTE  Right-click a value, then select Global Modify (page 59) to view and change the property in other control 
programs. 

 

 
 

Using a Logic page to troubleshoot 

The Field Assistant application monitors your system and provides feedback. If you get unexpected feedback, you 
can use a Logic page as a troubleshooting tool. On the Logic page, work your way backward (right to left) through 
the sequence in the control program to discover what caused the problem. See Microblock Reference to 
understand what each microblock in the sequence is doing. 
  

Unexpected feedback Possible cause 

Space temperature reads 
excessively high or low 

• The sensor has a short (or open) circuit. Verify wires are properly 
connected at the sensor and controller. 

• A sensor is missing or configured incorrectly. Open the sensor or input 
microblock from the Logic page to verify its configuration. 

Equipment displays an unexpected 
color - effective setpoints are 
different than the programmed 
setpoints 

NOTE  Equipment operates using effective setpoints. Open the Setpoint 
microblock from the Logic page and check the following: 

• Hysteresis 

• Demand Level 

• Optimal Start 

• Timed Local Override (TLO) 

• Setpoint Adjust 

Gaps in trend data on trend graph Usually gaps result if network communication was disrupted or a point was 
temporarily disabled. 

If the gap is not the result of interrupted communication, send reports 
more frequently. From the Logic page, open the trend microblock that 
displayed the gap in data, then decrease the notification threshold so that 
it is approximately 40% of the buffer size (allocated memory size) for that 
microblock. 
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Unexpected feedback Possible cause 

The Field Assistant application is 
not receiving alarms from a BACnet 
alarm microblock 

Locate the microblock on the Logic page. If the color square on the 
microblock is black, the alarm is disabled. To enable it: 

1 Click the microblock.  

2 In the microblock pop-up, click the Alarms button.  

3 On the Enable/Disable tab, select Potential alarm source. 

The equipment is on when I expect 
it to be off, or off when I expect it to 
be on 

Use the Logic page to determine whether the program is sending an 
unexpected signal and why, or if the problem is with the physical 
equipment. For example, the On-Off-Auto (OOA) switch on the controller for 
that equipment may be locked in the On (Hand) position. 

Sensor value on the Properties 
page does not match the reading 
from handheld sensor 

Calibrate the sensor.  

On the Logic page, check to see if the output point is locked on. 

 

 
 

To lock a BACnet point of value 

You can lock certain editable parameters to a specified setting from the Properties page or microblock popup.  

1 Select the Lock checkbox. 

2 Type the value you want to send to the controller. 

3 Click Accept. 

NOTE  Locked values are indicated by a dashed yellow line on graphics. 

  

On Properties page > Control Program tab, click  to locate the point you wish to lock. 
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On the microblock popup: 

1. Click on the underlined Name or Reference Name of the point on any of the Properties tabs to open the 
point/properties details popup.  

2. Click Properties page > Details tab to lock a value. 
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Using schedules, your equipment can maintain one set of setpoints during occupied periods to provide comfort, 
and it can maintain a different set of setpoints during unoccupied periods to reduce energy consumption. 
Schedules are the most effective cost-saving strategy. 

NOTE  Do not include preheating or precooling time in your schedules. Optimal Start (page 41), another cost-saving 
strategy, automatically calculates and controls precise preheating and precooling routines.   

 CAUTION  Schedules are managed in the i-Vu® application and will override any that you set in Field 
Assistant. You must use the i-Vu® application to set up Holiday schedules. You can use Field Assistant to set up 
temporary schedules. 

 

 
 

To view schedules 

1 Select a controller on the navigation tree. 

2 Click Schedules page > View tab. 

3 Optional: Click an Effective bar to view all the schedules that contribute to the resulting schedule. 

NOTE  When multiple schedules affect a controller, Field Assistant sorts the schedules by priority—the higher 
the priority, the closer the schedule is to the Effective bar. You set a schedule's priority when you add a 
schedule. 

 

 
 

To apply a schedule to a controller 

Schedules in Field Assistant are typically based on zone occupancy.  

1 On the navigation tree, select the controller you want to schedule.   

2 Click the Schedules page > Configure tab. 

3 Click Add. 

4 Select a Priority. A schedule's priority determines whether affected zones will use occupied or unoccupied 
setpoints. 
  

Select... For... 

Weekly A typical occupied period 

Exception An unoccupied period that overrides a Weekly schedule 
NOTE  This functions the same as a Holiday schedule. 

  

Creating and modifying a Field Assistant schedule 
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5 Select a Type. See table below. 

6 Enter desired values in the fields below Description (50 characters maximum). 

7 On the graph, change a time segment's Start and End times by doing one of the following: 

○ Click the segment, then type the times in the Start and End fields. 

○ Click and drag either end of the segment or the entire segment.  

8 Optional:  Click Add Time Period to add one or more segments to the schedule. Or, select a segment and click 
Delete Time Period to delete that segment. 

9 Click Accept. 

   

Type Schedule runs 

Weekly Every week on the specified days 

Date On a single, specified date 

Date Range Between two specified dates 

Date List On multiple, specified dates 

Wildcard According to a repeating pattern (For example, the second Tuesday of every month) 

Continuous Continuously between specified times on two separate dates 

Dated Weekly Weekly between a start date and an end date (For example, the summer break in the school 
year) 

 

 
 

To edit or delete a schedule 

1 Select the controller whose schedule was defined. 

2 Click Schedules page > Configure tab. 

3 Select the schedule you want to edit or delete. 

4 Edit the fields you want to change or click Delete. 

5 Click Accept. 
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Field Assistant can read and store equipment status values over a limited time and then displays this information 
in a trend graph to help you monitor the equipment’s operation.  

 

You can collect trend data for any point value in the Field Assistant system. The controller reads point values at 
intervals that you define and then stores that data in the controller. A controller has limited memory for storing 
trend data.  

After you set up the desired points for trend data collection (page 69), you can:  
• View built-in trend graphs that show a single point (page 69) 
• Create custom trend graphs with multiple points (page 70)  

  

 

  

 

 
 

Trends 
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To collect trend data for a point 

Before you can look at a trend graph for a point, you must enable trending for that point and then tell Field 
Assistant how you want the equipment to collect the point's data. 

1 On the navigation tree, select the controller that has the point you want to trend. 

2 Click the Trends button drop-down arrow, select Disabled Points, then select the point. 

3 Click the Enable/Disable tab, then check Enable Trend Log. 

4 Enter information in the appropriate fields. See table below. 

5 Click OK. 

TIP  You can set up all trends for a piece of equipment at once on the Trend Sources tab of the equipment's 
Properties page. 

  

Field Notes 

Sample every _:_:_ (hh:mm)  This method records (samples) the point’s value at the time 
interval you define in this field. 

NOTE  Be sure to set trend intervals to one minute or greater.  

Sample on COV 
(change of value) 

This method records the point’s value only when the value 
changes by at least the amount you enter in the COV Increment 
field. 

NOTE  Use this method for a binary point or for an analog point 
that has infrequent changes in value. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines 
the BACnet object. Although the Object Name field can be edited, 
it is not recommended. The Notification Class is set to 1 to 
receive alarms generated by Carrier controllers. 

 

 
 

Viewing a built-in, single-point trend graph 

1 On the navigation tree, select the equipment whose trend you want to view. 

2 Click the Trends button drop-down arrow, select Enabled Points, and then select the graph you want to view. 

3 Select the View tab. See Using trend graphs (page 72). 

  
NOTE  On the Configure tab, you can: 
• Enable/disable the grid. 
• Set the time range for the X axis. For example, enter 7 days to see the data for the last week. 
• Turn off autoscaling so that you can define a range for the Y-axis 
• Type a Y-axis label that will appear on the right side of the graph. 
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Creating a custom trend graph 

When creating a custom trend graph, you can select up to 16 points. If you select more than 4 points or points with 
different units, the Field Assistant application splits the data into subgraphs. Each subgraph can show a maximum 
of 4 points with similar units.  

 

  
NOTE  You must enable trending for points that you want to include in the custom trend graph. See To collect trend 
data for a point (page 69). 

 
 

To create a custom trend graph 

1 On the navigation tree, select the area or equipment where you want to see the graph. 

2 Click the Trends button drop-down arrow, then select New Trend Graph. 

NOTE  If the Trends button does not have a drop-down arrow, the New Trend Graph page is already displayed. 

3 In the tree on the New Trend Graph page, use Ctrl+click or Shift+click to select the points (16 maximum) that 
you want to see on a graph.  

NOTE  The tree shows only points that have trending enabled. See To collect trend data for a point (page 69). 

4 Click Save. 

5 Type a Name for the graph that will appear at the top of the graph and in the Trends button drop-down list. 

6 Click OK.  

7 Select: 

○ The View tab to see the custom trend graph. See Using trend graphs (page 72). 

○ The Configure tab to edit the trend graph. See To edit a custom trend graph (page 71). 



 

 
 

Field Assistant v7.0 Carrier Proprietary and Confidential CARRIER CORPORATION ©2018   
Help  All rights reserved 
 71 

 

 
 

To edit a custom trend graph 

1 On the navigation tree, select the area or equipment where you created the graph. 

2 Select the Trends > Configure tab. On this page, you can: 
• Change the name of the custom trend graph 
• Enable/disable the grid 
• Set the time range for the X axis 
• Edit a subgraph's Y-axis label that will appear on the right side of the graph 
• Turn off autoscaling so that you can define a range for the Y-axis 
• Add/delete subgraphs (see instructions below) 
• Add/delete points (see instructions below) 
• Change a point's name on the graph 
• Change a binary point's active/inactive text on the graph 
• Click Delete Trend Graph to delete the entire custom trend graph 

  

To add a subgraph to a custom trend graph 
1 Click Add below the Subgraphs list. 

2 Type a Y-axis label. 

3 Click Add below the Points list. 

4 Select a point in the Data source tree. 

NOTE  The tree shows only points that have trending enabled. See To collect trend data for a point (page 69). 

5 Repeat steps 3 and 4 to add up to 4 points to the subgraph. 

6 Click Accept. 

NOTE  To delete a subgraph, select it in the Subgraphs list, click Delete below the list, and then click Accept. 
  

To add a point to a subgraph 
1 Select the subgraph in the Subgraphs list. 

2 Click Add below the Points list. 

3 Select a point from the Data source tree. 

NOTE  The tree shows only points that have trending enabled. See To collect trend data for a point (page 69). 

4 Click Accept. 

NOTE  To delete a point, select the appropriate subgraph, select the point, click Delete below the Points list, and 
then click Accept. 
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Using trend graphs 

 
  

 NOTES   

• A gray triangle at the top of a graph indicates a note from the system. Hover your cursor on the triangle to see 
which of the following occurred: 

○ Equipment received a time synchronization from its network router or from the Field Assistant 
application.  

○ Trend Historian has been enabled or disabled.  

○ Trend Log has been enabled or disabled. 

○ The trend object ID of a third-party trend source has been changed. For information only, you do not need 
to do anything. 

• Click  at the top of the Field Assistant page to print the graph. You may need to set your printer's 
orientation to Landscape. 

• Toolbar options are also accessible by right-clicking a trend graph. 

• You can check Display gap in graph line for missing data on an individual trend graph page. 
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To view trend data in a spreadsheet program 

You can save trend data as csv data that you can open in a spreadsheet program such as Microsoft® Excel®. 

1 On the Trends > View tab, select  > Save as CSV data. 

2 Save the data (.zip file) wherever you want. The .zip file contains the following: 
• A .csv file for each trend source (point). The filenames match the point names. 
• A Combined folder containing a file with the combined data for all of the graph's trend sources. 

3 Open the .csv file in a spreadsheet program. 

  
NOTES 

• You will need to convert the data in the spreadsheet's Time column to a readable date/time format. 

• If you use Microsoft® Excel® on a Mac and the converted date shows the wrong year, do the following: 

1. In Excel, go to File > Options > Advanced. 

2. Scroll down to the section When calculating this workbook, and then uncheck Use 1904 date system. 
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1 On the navigation tree, select the alarm source. 

2 Select the Properties page and click on the specific point to open the point/properties details popup. 

3 Click the Alarms tab in the popup. 

4 Make changes to the fields as needed. See table below. The fields can vary for different types of alarm 
sources. 

5 Click Accept or Apply. 

 TIP  To set up all the alarms for a piece of equipment at once, click Properties, then select Alarm Sources. 

 

Field Notes 

Potential alarm source Select the checkbox to enable the alarm source to generate alarms. Clear the 
checkbox to disable the alarm source. 

Alarm Select to have the alarm source generate an alarm when the specified 
conditions occur.   

• For a binary input, enter the conditions for generating an alarm. 

• For an analog input, type the low and high limits that, when exceeded, will 
generate an alarm.  
 

Deadband  The amount inside the normal range by which an alarm condition 
must return before a return-to-normal notification is generated. 

NOTE  If the Status checkbox is selected, the alarm condition currently exists. 

Return to Normal Select to have the alarm source generate a return-to-normal when the alarm 
condition returns to a normal state. 

Fault Select to have an alarm generated if the alarm source is not configured 
correctly. 

NOTE  If the Status checkbox is selected, the alarm source is currently 
misconfigured. 

Alarm requires 
acknowledgement 

Select to have Field Assistant require that an operator acknowledge the alarm. 

Return requires 
acknowledgement 

Select to have Field Assistant require that an operator acknowledge the return-
to-normal. 

Classified as Critical This property determines the color of the system-wide alarm button when the 
alarm comes in. 

  = Critical       = Non-critical 

To set up, edit, or disable a single alarm source 
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Field Notes 

Event State The current state of the alarm source can be: 
• Normal—value is normal 
• Off normal—the value is not normal (binary only) 
• Fault—the alarm source microblock may be misconfigured 
• High Limit—the value exceeds the normal range (analog only) 
• Low Limit—the value is below the normal range (analog only) 

BACnet 
Configuration: 
  

Dial on alarm 

N/A  
  

Notification Class Do not change this field. 
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Use Field Assistant reports to monitor and troubleshoot your system. See the table below for a list of all reports. 
  

 

The Reports button drop-list varies depending on 
your navigation tree location and your connection. 

 

  

This pre-configured report... allows you to... 

Alarms  

Alarm Sources Create a summary of potential alarm sources (page 74). 

Commissioning  

Test & Balance View the damper calibration parameters. 

Equipment  

Locked Values Find all locked points and locked values. 

Network IO Verify the programming and status of all network points—especially useful for 
commissioning controllers used for third-party integration. 

Point List View the details of all points. Verify that all points have been checked out 
during commissioning. Also, create custom lists for other contractors. For 
example, create a list of BACnet IDs or Web services links. 

Network  

Controller Status Discover network communication problems (shown as purple squares on the 
report) that need troubleshooting. The report also shows boot and driver 
version, download information, and if controller has 4.x or later driver, the 
report shows the serial number and Local Access port status.  

Equipment Status Display the thermographic color, status, and prime variable of each control 
program. 

 

 
 

Reports 
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To run a report 

1 Select an item on the navigation tree. 

NOTE  A report shows data for the selected tree item and all its children. 

2 Click the Reports button drop-down arrow, then select a report. 

3 On the Options tab, define the layout and content of the report. 

NOTES   

○ Changing the size and orientation of the printed page also changes the report layout on the View tab. 

○ To create a CSV (Comma Separated Values) file after you run the report, select Support CSV text format. 
See To create a PDF, Excel spreadsheet, or CSV file (page 77). 

○ The current operator's report options are saved so that when that operator logs in again, the same 
options are used. 

4 Click Run. 

5 Click PDF if you want to print the report. 

 

 
 

To create a PDF, XLS, or CSV file 

PREREQUISITE FOR CSV  You must enable Support CSV text format on the Reports > Options tab before you run 
the report. 
  

1 Run a report.  

2 Click PDF, XLS, or CSV. 

3 For XLS or CSV, click Open to view the file or Save to save it. 
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Although the Field Assistant application is a reliable front-end, you must perform periodic backups of the Field 
Assistant database to ensure a quick recovery in case of failure. To make sure that your controllers have the latest 
version of software, you must install periodic library upgrades. The sections below describe how to backup and 
restore the Field Assistant database and how to install the library updates. 

 

 
 

To update Field Assistant 

1 Go to the Field Assistant Launcher screen. 

2 Click Help and select Update. 

3 Browse to the .update file. 

4 Check under Notes: for any pertinent information regarding the patch. 

5 Click Apply and Restart Now, if necessary. 

 

 
 

To update the SAL library 

The Field Assistant application is equipped with a complete library. There are occasionally library (.sal file) updates, 
which contain the following files: 

• graphic (.view) 

• control program (.equipment) 

• driver (.driver) 

• screen (.touch or .bacview)  

 

NOTES 

• Get the latest updates from your Carrier representative. 

• The library update only changes default graphics. If you have edited your graphic in ViewBuilder, it is not 
updated. 

• Keep copies of the latest libraries in a safe place. In the event of a system restore, any updated .sal files must 
be reapplied. 

• The last digits in the sal library name are the release date of the library. 

 

 

 

System Management 
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Step 1: Upload new library to Field Assistant 

1 Obtain the updated library (.sal file) from Carrier Control Systems Support. 

2 Save the file to your computer in the iVu_Tools_x.x > sals folder. 

3 Start your system in Field Assistant. 

 

Follow these steps to implement the new equipment library: 
Step 2: Update the files for the routers 

1 Select the router that you wish to update in the navigation tree. 

2 Right-click and select Driver Properties.  

3 Select Properties page > Update tab.  

4 If the database contains two or more routers, you must check Change for all controllers of this type? in the 
Controller section. 

5 Click Update. A message appears Changes the driver and screen file to use the current library version. 
Continue?  

NOTE  If more than one router exists, the additional routers are listed below the Update button. 

6 Click OK.  

7 Click Accept. 

 

Step 3: Update the files for the controllers  

1 Double-click the controller in the navigation tree or right-click and select Configure.   

2 If you have multiple controllers of the same type, enable Change for all control programs of this type?. 

3 Click Update under Control Program. A message appears Changes the control program, view, driver, and 
screen file to use the current library version. Continue?  

4 Click OK. When the message Updated to the library version xx. appears, click Close. 

5 Repeat steps 1 - 4 for any additional types of controllers. 

6 Click Close again. 

 

Step 4: Apply the update to the control programs 

1 Select the router in the navigation tree and then select the Devices > Manage tab. 

2 Select control programs in the list on the page that are marked for download. 

NOTE  Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple control programs.  

3 Select All Content and click Download. 
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Troubleshooting a Local Access connection 

Inability to communicate over a Local Access connection may cause the following symptoms: 

• Question marks on Field Assistant Properties pages and Graphics pages 

• Cannot obtain a Modstat from the connected controller 

• Controller Status report displays purple for a connected BACnet/IP controller 

• Cannot download to connected controller 

• A message says Local Access is disabled or unable to connect 

• No controllers found in Field Assistant 

 

Possible cause Solution 

BACnet/IP network number 
in  Field Assistant does not 
match the number found in 
the controller 

Change the Field Assistant BACnet/IP network number to match the 
controller's IP network number.  

1 Select the System  or router on the navigation tree and go to the 
Devices page > Advanced tab. 

2 Type new network number in BACnet/IP network. 

3 Click Accept. 

Selected COM port is in use Shut down other applications such as PuTTY that may be running and holding 
the port open. 

Local Access is disabled Your manufacturer or representative must enable Local Access in the i-Vu® 
interface. 

 
 

Troubleshooting BACnet bindings 

Every controller has a Device Binding Table that contains all Device IDs that the controller communicates with and 
the network address of each device. This typically includes the Device ID of the BACnet Alarm Recipient.  

If the Field Assistant application is not receiving alarms/trends or if the a point's value is incorrect, you can view 
this table to see where the controller is looking for its data. 

1 On the Field Assistant navigation tree, select the router that has incorrect or missing data. 

2 On the Properties page,click the Show Bindings button. 
 

Troubleshooting and communications 
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To assign a controller as the Time Broadcaster 
On a small, stand-alone network of controllers, the time in the controllers is synchronized with the controller that 
you select as the Time Broadcaster. 

1 On the navigation tree, select the System . 

2 On the Devices page > Manage tab, click the Time Settings link. 

3 Select the router or controller from the Time Broadcaster drop-down list. 

4 A message appears for you to adjust the time intervals between broadcasts. 

5 Click Accept. 
  

To adjust the Daylight Saving Time schedule 

1 On the navigation tree, select the System . 

2 On the Devices page > Manage tab, click the Daylight Saving link. 

3 On the Daylight Saving tab, make changes as needed.  
NOTE  Click Update to automatically set the table's Begin and End dates for the next 10 years based on the 
system's timezone. This marks all controllers for a Parameters download. 

4 Click Accept. 

5 Click OK. 
  

If the updated dates are incorrect 
If you clicked Update but the dates are incorrect, your system's Java timezone data may be out-of-date. Do the 
following: 

1 Go to the Oracle Java SE Download site (http://java.sun.com/javase/downloads). 

2 Download the JDK DST Timezone Update Tool (tzupdater-.zip). 

3 In Field Assistant, go to the Devices page > Manage tab, click the Time Settings link. 

4 On the Daylight Saving tab, click Import. 

5 Browse to the tzupdater.zip file, select it, then click Open. 

6 Click Continue. 

7 Restart your system from the Field Assistant Launcher. 

8 On the Daylight Saving tab, click Update. 

 

 
 

To change controller time settings using Field Assistant 

http://java.sun.com/javase/downloads
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To run a manual command in Field Assistant:  

1 Press Ctrl+Shift+M to open the dialog box. 

2 Type the manual command in the dialog box, then click OK. 

  

Command Description 

bacnet showindex Displays all files (file name, size, date) downloaded to the selected 
controller. 

bbmd commands:  

   bbmd read <IP address> Reads the BBMD table of the controller at the given IP address. 

For example, to display the BBMD table in the BACnet device router at IP 
address 154.16.12.101, type:  
       bbmd read 154.16.12.101 

 bbmd update <network  
        number> 

Selects BBMDs on the specified network and marks them for download. If 
no network is entered at the end of the command, all networks in the 
system are scanned.  

For example, if the network number is 888, type: 
       bbmd update 888 

   bbmd view <network  
       number> 

Views the list of BBMDs that have been selected for the network number 
at the end of the command. Assumes the update has been run. 

For example: 
       bbmd view 888 

 bbmd write <table file> <IP  
        address>  

Writes the BBMD table into the controller at the given IP address.  

For example, to write the BBMD table in dallasbbmd.bdt into the BACnet 
device router at IP address 154.16.12.101, type: 
       bbmd write dallasbbmd.bdt 154.16.12.101 

   bbmd clear <IP address> Clears the BBMD for the specified controller. 

For example: 
       bbmd clear 154.16.12.101 

 bbmd dump <network>  
       <file> 

Writes to a file the BBMD from the specified controller. 

For example: 
       bbmd dump 888 dallasbbmd.bdt 

checkurls 1 Finds all network point exp: expressions for the selected item on the 
navigation tree. 

2 Converts the exp: expressions to bacnet:// equivalent expressions that 
the controllers use. 

3 Compares the equivalent bacnet:// expressions to the bacnet:// 
expressions currently downloaded in the controllers. 

4 Displays any mismatches. 

Manual commands 
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Command Description 

checkurls -p Does the same as checkurls, then adds any mismatches to the download 
queue as parameter downloads. 

checkurls -v Does the same as checkurls, but displays the exp: and bacnet:// 
expressions for all network points that were checked. 

commstat Gives a complete set of diagnostic information for all defined connections 
as well as information regarding all modems in the system. 

copy Displays a global copy utility that allows you to selectively copy trend 
graphs, custom reports and all editable properties from the selected 
equipment to other equipment in the system with the same control 
program. See To use Global Copy (page 61). 

download commands: Each of these commands performs an immediate download to a controller 
for the selected control program, device, or driver. 

   download m Downloads all content, including parameters, schedules, and BBMDs (if 
applicable). 

   download p Downloads parameters only. 

   download s Downloads schedules only. 

go commands:  

  go <refname or path> Goes to the point in the system that is referenced. 

For example: 
       go #oa_conditions 
or 
       go vav_1/m28 

go ~network Takes you to the network the selected object’s controller is associated to. 

go -logicpopup <refname> Goes to the microblock pop-up for the microblock that is referenced. You 
must run this command from the microblock’s equipment on the 
navigation tree. 

For example: 
      go -logicpopup rs 

go <device ID>/<object  
        ID> 

Goes to a device and object on the navigation tree. 

For example: 
      go 300550/AI:3 

 go <object ID> Goes to an object for the current device on the navigation tree. 

For example, if a module alarm reports a control program Locked I/O 
Alarm and references an error in program 11, click the link to go to the 
device, then go to the object by typing: 
      go PRG:11 

localhost Shows the IP address of the Field Assistant web server 

markdownload commands: These commands place the controller for the selected tree item on the list 
to download at a later time.  

markdownload Marks for an All Content download, that includes parameters, schedules, 
and BBMDs (if applicable). 
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Command Description 

markdownload p Marks for a Parameters download. 
 

markdownload s Marks for a Schedules download. 
 

memory Shows the amount of server memory allocated for the Field Assistant 
application and the amount being used.  

memory -free Releases unused server memory, then shows the Field Assistant memory 
usage before and after the release. 

modstat commands: These commands display a Modstat (page 88) report. 

NOTE  It is not necessary to download a controller before running a 
Modstat on it. Binding takes place when you run the modstat. 

   modstat Displays status of the controller at the current location, including: 

• Hardware components of the device 

• Software components of the device 

• Error conditions that may exist in the device 

• Date and time the device is using 

   modstat 8:<device instance  
        number> 

Displays status for a specific controller in the IP network using the 
controller’s ID. Your location in the system does not have to be the 
controller you are querying. 

For example: 
       modstat 8:489202 

   modstat mac:<network  
   number>,<media type>: 
   <mac address> 

Displays a Modstat for a specific controller in the system using the 
controller’s MAC address. Network number is the number of the network 
this controller is on; media type is the type of network the controller is on; 
MAC address can be either the controller address or the IP address and 
depends on the controller’s media type.  

Media types allowed are: 

• bacnet/ip  or  b 

• ms/tp       or  m 

• ethernet   or  e 

For example: 
       modstat mac:48161,arcnet:2 
                   or 
       modstat mac:888,bacnet/ip: 172.16.101.119 

paramupload Uploads parameters (editable properties) to the Field Assistant application 
from the equipment or driver at the current location and below. If you want 
to upload editable properties for all equipment under a particular router, 
navigate to the router or the network on the navigation tree.  
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Command Description 

ping Ping to verify communication between IP devices. You cannot ping devices 
on non-IP networks. To run this command type: ping <hostname> 
where <hostname> is the IP address or device name. 

For example: 
       ping 192.168.168.1 
(will ping the IP address 4 times)                 

rebuild Rebuilds a Properties page. Use if you make changes to control program 
property text in the Snap application. 

reload Reloads a control program. Use if you make changes to control program in 
the Snap application. Reloading updates all instances of the control 
program throughout the system and marks the controller(s) for download. 
The Field Assistant application determines the type of download based on 
what changed in the control program. 

restartmodule Restarts the current controller.  

revert Resets the selected driver or control program to its default values. 

setdefault Sets the current page as the default view for the selected action button 
and the selected tree location. 

shutdown Shuts down the Field Assistant Server application. This stops 
communication between the server and the client, but does not close any 
open Field Assistant pages.  

storetrends Uploads trend data from the controller(s) to the database for all equipment 
at and below the selected item on the navigation tree. This command 
stores trend data for points that have Trend Historian enabled. 

timesync Synchronizes the time on all controllers at the current location and below 
to the time on the server. Run this command only from a location on the 
navigation tree.  

NOTE  For CNN networks, executing a timesync on a controller sends the 
timesync to its Gateway, and all the controllers under that Gateway. 

updatedriver commands:  

 

updatedriver Updates the selected controller to the latest version of its driver. 

 

whereami Displays the full path for the current location and gives the display and 
reference names of the action button, category, instance and tab. If the 
selected tree location differs from the location shown in the action pane 
(for example, a point trend page), whereami returns information on both 
locations. 

Use this command when you create links in ViewBuilder. 

zap Restarts the current controller.  
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DEBUG MODE saves considerable time when troubleshooting custom control programs for programmable 
controllers. Typical operating mode in the Field Assistant application always downloads full source, which is time-
consuming. While operating in DEBUG MODE, full source is kept in the database and is not downloaded to the 
controller.  

  CAUTION  Never leave your Field Assistant system without unchecking DEBUG MODE first and and then 
downloading all content. The source files are not in the controller until you complete both steps.   

To use DEBUG MODE 

1 Select the custom control program in the navigation tree and either double-click it or right-click and select 
Configure.  

2 Check DEBUG MODE. 

3 Download the new or edited control program. See Working with control programs (page 24).  

4 Before logging out or switching to a different controller, select the control program in the navigation tree and 
either double-click it or right-click and select Configure.  

5 Uncheck DEBUG MODE. 

6 Download All Content from the Devices page > Manage tab or any page that has a Download button.  

 

 
 

Using DEBUG MODE 
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When control programs, views, touchscreen, and BACview® files are created by an original equipment 
manufacturer (OEM), they cannot be used in a Field Assistant system without the creator's permission. However, 
the creator can produce a key for a system with a different license that will grant permission to the key's recipient. 

 

If you receive a key, put it in a convenient location on your computer. You may want to keep it in the i-Vu_Tools_x.x 
> resources > keys folder. 

 

1 In the Field Assistant Launcher, click Help and select Permission Keys from the drop-down list. 

 

 

2 To activate a key, click Add, browse to your key file and click Open. 

3 To delete a key from your system, select the key in the table, then click Delete. 

 

NOTE  Red text in the table indicates the key has a problem such as it does not apply or has expired. See the Notes 
column for an explanation. 

 

 

 
 

Permissions Keys 
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A Modstat (Module Status) provides information about a controller and verifies proper network communication with 
the controller. 

 

 
 

To obtain a Modstat 

You can get a controller's ModStat in the following places: 

• Open device—In the Field Assistant application 

• i-Vu® XT device—In the Field Assistant application or the controller's setup pages 
  

In the Field Assistant application 
Use one of the following methods:  

• Right-click a router or control program in the navigation tree, then select Module Status. 

• Select a router on the navigation tree. On the Properties page, click Module Status. 
  

In the controller's setup pages (i-Vu® XT device only) 
1 Connect an Ethernet cable from a computer to the controller as shown below. 

 

 
  

2 If your computer uses a static IP address, set the address to 169.254.1.x, where x is 2 or greater. If it uses a 
DHCP address, leave the address as it is. 

3 Turn off the computer's Wi-Fi if it is on. 

4 Open a web browser on the computer.  

5 Navigate to http://local.access or http://169.254.1.1 to see the controller setup pages. 

 

 
 

Using a Modstat to troubleshoot your system 
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Modstat field descriptions 

NOTE  Modstats vary for different types of controllers. The list below describes all information that could appear on 
any Modstat. If a description differs between different generations of controllers, the generation is noted. 
  

Field Description 

Date/Time Date and time the Modstat was run 

CM The controller's rotary switch address (MAC address) 

Model Name Identifies the Product Type 

Device Instance A unique ID assigned to the controller  

Driver built When the driver was built 

Downloaded by When and where the last download was performed 

Application Software Version The name of the first control program that is downloaded 

Flash Archive Status Shows the validity, date, and time of the most recent archive of 
parameters and status to the controller's permanent flash memory. 
The archive takes place once a day. 

# PRGs initialized 
# PRGs running 

If applicable, the number of control programs that were downloaded 
vs. the number that are running. If these numbers are not the same, 
the controller has a problem such as lack of memory.  

Firmware sections in flash 
memory 

The name, version, and date of the driver 

Reset Counters: Open device: The number of times each of the following events have 
occurred since the last time the controller was formatted. 

i-Vu® XT device: The number of times each of the following events 
have occurred since the last time the controller was commanded to 
clear the reset counters. 
See NOTE below this table. 

         Power failures Interruption of incoming power 

         Brownouts Low-level incoming power 

         Commanded boots Includes commands issued from the Field Assistant interface such as 
the zap manual command, plus commands issued during a memory 
download. 

         System errors Error in the controller's firmware or hardware 

         Watchdog timeouts Watchdog is firmware that monitors the firmware for normal 
operation. If watchdog detects a problem, it restarts the firmware. 

         S/W Watchdog 
         timeouts 

Watchdog is firmware that monitors the application firmware for 
normal operation. If the watchdog firmware detects a problem, it 
restarts the application firmware. 
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Field Description 

         H/W Watchdog 
         timeouts 

H/W Watchdog will restart the controller if it detects a severe problem 
with the controller's operating system 

System status Gives the current status of the controller's operation.  

Network status Gives the current status of the controller's networks. 

System error message history Open device: High-severity errors since the last memory download or 
format. Shows the first 5 and last 5 messages. 

i-Vu® XT device: High-severity errors since the last memory download. 
Shows the most recent 10 messages. 
See NOTE below this table. 

Warning message history Open device: Low-severity errors and warning messages since the last 
memory download or format. Shows the first 5 and last 5 messages. 

i-Vu® XT device: Low-severity errors and warning messages since the 
last memory download. Shows the most recent 10 messages. 
See NOTE below this table. 

Information message history Open device: Information-only messages since the last memory 
download or format. Shows the first 5 and last 5 messages. 

i-Vu® XT device: Information-only messages since the last memory 
download. Shows the most recent 10 messages. 
See NOTE below this table. 

Manifest revision Firmware revision 

Installed bundles Components of the firmware 

ARC156 reconfigurations during 
the last hour 

An ARCNET network normally reconfigures itself when a controller is 
added to or taken off the network. The Total field indicates the 
number of reconfigurations in the last hour. Initiated by this node 
indicates the number of reconfigurations initiated by this controller. 
Typical sources of the problem could be this controller, the controller 
with the next lower rotary switch address, any controller located on 
the network between these two controllers, or the wiring between 
these controllers. An excessive number in these fields indicates a 
problem with the network.  

BACnet comm errors in the last 7 
days 

BACnet communication errors usually indicating dropped packets 
caused by high traffic on network. 

Core (or Main) and Base board 
hardware 

Gives the following information about the controller's boards: 
• Type and board numbers that are used internally by Carrier. 
• The manufacture date and serial number. 
• Open device only: The core board's RAM and Flash memory. 

RAM is used for driver and control program executables. 
Flash memory is used for firmware and file storage. See Flash 
storage size below. 

Number of BACnet objects The number of BACnet objects that were created in the device and the 
number of those objects that are network visible. 

Largest free heap space Size of the largest piece of unused dynamic memory 
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Field Description 

Database size Open device: Size of the controller's memory designated for running 
programs. Database memory is used for control program parameters, 
status and history; trends, schedules, and alarms; and driver 
parameters, status and history. 

i-Vu® XT device: Size of the controller's memory. 

Flash storage size The size of the flash memory that is not used by the firmware. This 
memory is used for file storage and archiving. 

 Archive storage size The amount of flash memory remaining for archival after files are 
downloaded. 

 File storage size The size of all files (control programs, graphics, driver, etc.) 
downloaded to the controller. How much information is in these files 
depends on whether the controller's Download All Content option is 
selected in Field Assistant. 

Raw physical switches The readings used to test the DIP or rotary switches 

Network Information Open device: The various network addresses for a controller installed 
on an Ethernet. The Current and Assigned  addresses will be the 
same unless: 
• The Assigned addresses were changed in PuTTY. 
• The controller's DHCP/Assigned DIP switch was moved to the 

DHCP position after the Assigned addresses were defined. 
• The Enable IP configuration changeover on the BACnet Router 

Properties page is being implemented. 
i-Vu® XT device: The various network addresses for the controller. The 
Current and Assigned  addresses will be the same unless the Enable 
IP configuration changeover on the BACnet Router Properties page is 
being implemented. 

Route Information BACnet networks that a router is currently routing traffic to. The list 
changes as BACnet routers are added or removed from the system. 

Ethernet statistics Diagnostic counters directly related to the ethernet communications 
hardware. 

  

NOTE  i-Vu® XT device only—If you want to clear the Reset counters and the three message history fields, click the 
Clear Counts/Logs button on the controller's Properties page in the Field Assistant application or in the i-Vu® XT 
device's setup pages that you access through the Service Port. 
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Important changes to this document are listed below. Minor changes such as typographical or formatting errors are not 
listed. 
  

Date Topic Change description Code* 
7/30/18 Computer, operating system, and and 

database requirements for Field 
Assistant 

Correction - i-Vu Tech Tools can be installed on a 32-bit computer X-TS-CI-E-RD 

  
*  For internal use only 
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